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Chapter 1 — General Information

1-1 Introduction
Anritsu Master Software Tools (MST) is a Microsoft Windows compatible program for transferring, editing, 
and saving measurements, markers, and limit lines from an Anritsu instrument to a PC or laptop (hereafter 
referred to as “the computer”). It does not function on earlier versions (prior to XP) of the Microsoft Windows 
operating system. Refer to “System Requirements” on page 1-2 for complete system requirements.

To use MST and this guide to their full advantage, users should be familiar with their Anritsu instruments and 
the various measurements that they can make.

1-2 Features, Options, and Capabilities
MST provides these features, options, and capabilities:

• Download measurements from the test instrument’s memory to the computer for storage and analysis.

• Capture live traces on the computer. Files saved on an instrument can be retrieved through MST.

• Upload saved measurements from the computer to the test instrument.

• Compare multiple, Spectrum Analyzer measurement traces using drag, drop, Trace Math, and trace 
overlay features.

• Add, delete, and modify the scale of, Limit Lines and Markers of graphs.

• Modify the instrument’s Cable List with the Cable Editor.

• Modify the instrument’s Antenna List with the Antenna Editor.

• Modify the instrument’s Signal Standard List with the Antenna Editor.

• Create, upload, download, or edit Pass/Fail mode lists for many measurement modes including: 
WCDMA/HSDPA, GSM/GPRS/EDGE, Fixed & Mobile WiMAX, CDMA, EV-DO, LTE, and TD-LTE.

• Create, upload, download, or edit Script Master Files for GSM/WCDMA.

• Display power level, calibration status, and GPS information along with a measurement, in one report.

• Create and upload custom language files to the instrument to customize soft key labels and messages.

• Export measurement data as text files for use in spreadsheets or other documents.

• Create reports in HTML format for use in many applications.

• Export measurements as graphic files (.jpg format).

• Export measurements as CSV (Comma Separated Values) files.

• Update the instrument with the latest firmware available from: http://www.anritsu.com.

• Store an unlimited number of data traces to a computer, easing the task of analyzing and monitoring 
historical performance.

• Connect to a computer using USB, Ethernet LAN, or a Direct Ethernet connection.

• Display measurement locations using Microsoft Map Point and GPS location mapping.

• Convert DAT files from Anritsu Handheld Software Tools into Anritsu MST file formats.

• Combine spectrum analyzer traces into one spectrogram with the Folder Spectrogram tool. It does 
combine spectrograms into a “super spectrogram.”

• Create files with the Script Master to set up measurement parameters and create automated test 
procedures that aid field technicians or FAEs with measurement testing.

• Context menus simplify access to many functions that are available on the pull-down menus and toolbar 
buttons, or to functions, commands, and options specific to the active measurement window.
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1-3 System Requirements
The minimum requirements and recommendations are:

• Windows XP, Service Pack 2 or higher

• Windows Vista (32 bit or 64 bit)

• Windows 7 (32 bit or 64 bit)

• Windows 8 (32 bit or 64 bit)

• Windows 10 (32 bit or 64 bit)

• 1G of RAM minimum

• 1G of available hard disk space

• A USB port (USB 1 required, USB 2.0 recommended) and/or an Ethernet 10/100 Base T connection for 
communication with certain test instruments.
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Chapter 2 — Quick Start--copy

2-1 Introduction
This Quick Start chapter provides instruction about installing MST and describes the various connection 
methods for Anritsu instruments. The use and application of the features of MST are covered in more depth in 
later chapters.

2-2 Installation of MST
Follow these steps to install MST on a computer. Refer to “System Requirements” on page 1-2 for requirements 
for installation.

1. Download the MTS software package with the Anritsu Tool Box from this site:
https://www.anritsu.com/en-US/test-measurement/support/downloads/software/dwl19049

2. Make sure that .Net 3.5 and .Net 4.7 are installed prior to installing MST. 

3. Install MST by running this file: Anritsu_SWT_Full_Installer_Vn.nn.exe from the download folder in 
Step 1 where n.nn are the version and release. For example, Anritsu_SWT_Full_Installer_V1.18.exe.

4. Follow the prompts. When this guide refers to folders, it uses the defaults provided by the installation 
wizard. The location of your files might be different.

5. Test the MST installation by running it from the Start menu, a desktop shortcut, the Anritsu Toolbox, or 
the Taskbar.

2-3 Connection Methods
There are several methods of connecting an Anritsu instrument to a computer and to MST.

• The methods of connecting Anritsu test instruments through a LAN to MST (instruments must have an 
Ethernet port):

• Ethernet through a LAN using DHCP 

• Ethernet through a LAN (with manual IP address) 

• Direct Ethernet (using a crossover cable with manual IP address) 

• These are the methods of connecting Anritsu test instruments that do not use a LAN:

• USB 

• Serial-to-serial 

• USB-to-serial 

Each method is diagrammed and its required settings explained.  

Note Not all connection methods are compatible with all instruments.

https://www.anritsu.com/en-US/test-measurement/support/downloads/software/dwl19049
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2-4 Connection and Configuration Using LAN
This section describes how to connect a BTS Master instrument (as a representative of Anritsu’s advanced 
instruments) to MST using LAN connection methods listed in “Connection Methods”. For information and 
instruction for other instruments, refer to “Connection and Configuration with Other Methods” on page 2-21.

Ethernet LAN Connections

Connect the Instrument to the Computer through a LAN
Use standard Ethernet cables to connect the test instrument and the computer to a LAN (using an Ethernet 
hub). There are two LEDs integrated into the Ethernet port on the test instrument. The amber LED indicates 
the presence of LAN voltages—a live LAN connection—and the green LED flashes to show that LAN traffic is 
present.

Continue with manually configuring IP address of the test instrument.

Figure 2-1. Ethernet LAN Setup

BTS Ethernet Port

Ethernet Hub
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Connect the Instrument to the Computer through a LAN to use DHCP
Use this section to set up the instrument and computer to allow the network to choose the IP address for the 
instrument. 

Continue with  manually setting IP address or with DHCP IP address allocation.

Figure 2-2. Ethernet Hardware Setup

BTS Ethernet Port

DHCP Server

Ethernet Hub
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Configure the Test Instrument’s IP Address with DHCP

To configure an instrument’s IP address using DHCP:

1. Connect the computer and instrument to a LAN which is connected to a DHCP server. See Figure 2-2.

2. On the test instrument, press the Shift key, then the System [8] key. The test instrument’s System menu 
displays.

3. Press the System Options soft key, and then the Ethernet Config soft key. The Ethernet Editor window 
displays.

4. Press the Type soft key to select DHCP; DHCP will be underscored. See Figure 2-4.

5. Check for an IP address at this time in the Ethernet Editor window. If an address appears, the 
instrument is ready for connection to MST. Skip to “Configure MST” on page 2-13.

6. Press the Enter button. The test instrument is ready to obtain an IP address from the DHCP Server.

7. Power cycle the test instrument.

Note The address might change each time the instrument is booted; in these cases, you enter a new 
address for each MST session.

Figure 2-3. Ethernet Editor Window: DHCP

Figure 2-4. Type Soft Key Showing DHCP Selected

First Octet Second Octet Third Octet Fourth Octet
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8. Immediately after the re-boot the IP Address obtained from the DHCP Server momentarily displays near 
the top left portion of the screen. Write down the IP address.

If you miss seeing the IP address, you can view the IP Address from the System menu. Choose a or b to 
view the IP address.

a. Press the Shift key followed by the System [8] key, then press the Status soft key. The Status 
window opens. The IP address is listed first.   

OR

b. Press the System Options soft key followed by Ethernet Config soft key. The Ethernet Editor 
window displays the IP address, as shown in the picture below.

Either way, make note of the IP address so that you can enter it in MST. Continue with “Configure MST” 
on page 2-13

Figure 2-5. IP Address Display on Instrument

Figure 2-6. IP Address in Instrument Status Display

Figure 2-7. IP Address Display in Ethernet Editor Dialog
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Configure the Test Instrument’s IP Address Manually

To configure an instrument’s IP address manually:

1. On the test instrument, press the Shift key, then the System [8] key. The test instrument’s System menu 
displays, see Figure 2-8 (left).

Note

The IP address and the Gateway and Subnet masks in the following figure are examples only. 
Request address information from your IT administrator.
If the Ethernet Editor window does not display, this is because your instrument does not support an 
Ethernet connection; in this case try connecting with a USB or serial cable.

Figure 2-8. BTS Master Instrument System, System Options, Ethernet Menus
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2. Press the System Options soft key, see Figure 2-8 (left), then the Ethernet Config soft key, see Figure 2-8 
(middle). The Ethernet Editor displays and the Ethernet menu, see Figure 2-8 (right) displays along the 
right side of the instrument display.

3. Press the Type soft key to select Manual (it shows as underscored). The cursor moves to the IP address 
row and the First Octet field.

4. Set the IP address to 192.168.1.100 or use the address your local IT administrator supplies. Use the 
number keypad, the up/down arrow keys, or the rotary knob to change the value in the octet field. After 
the value is entered in the First Octet field, use the octet soft keys, see Figure 2-11, or the left/right 
arrow keys to move to the next octet field.

Figure 2-9. Ethernet Editor Dialog

Figure 2-10. Type Soft Key

Figure 2-11. Octet Soft Keys

First Octet Second Octet Third Octet Fourth Octet
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5. Press the Field soft key so that G-Way is underscored. The cursor moves to the First Octet field of the 
Gateway address row. 

6. Set the Gateway address to 192.168.1.1 or use the address your local IT administrator supplies. Use the 
number keypad, the up/down arrow keys, or the rotary knob to change the value in the Octet field. After 
the value is entered in the First Octet field, use the Octet soft keys, see Figure 2-11, or the left/right 
arrow keys to move to the next Octet field.

7. Press the Field soft key so that Sub is underscored. The cursor moves to the First Octet field of the 
Subnet address row. 

8. Set the Subnet address to 255.255.255.0. Use the number keypad, the up/down arrow keys, or the rotary 
knob to change the value in the octet field. After the value is entered the First Octet field, use the Octet 
soft keys, see Figure 2-11, or the left/right arrow keys to move to the next Octet field.

9. Press Enter to accept the changes or Esc to discard.

Configure the Computer’s IP Address 
1. On the computer, go to the Ethernet Settings dialog.

Figure 2-12. Field Soft Key: G-Way Underscored

Figure 2-13. Field Soft Key: Sub Underscored

Figure 2-14. Windows Network Connections Selection
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2. Click Ethernet. The Network Connections dialog displays. 

3. Click Ethernet. The Ethernet Status dialog displays.

Figure 2-15. Choosing Ethernet from Network Connections

Figure 2-16. Ethernet Status Dialog
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4. Click Properties. The Ethernet Properties dialog displays. 

Figure 2-17. Ethernet Properties: Networking Dialog
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5. Select IPV4 and click Properties. The Internet Protocol Version 4 (TCP/IPv4) Properties dialog displays. 

6. If you are using DHCP, click Obtain an IP Address automatically and click Obtain DNS server address 
automatically and skip to “Configure MST” on page 2-13. Otherwise, continue with Step 7. 
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7. Click the Use the following IP address: button and enter the IP, Subnet mask, and Default gateway 
information (that your network administrator provides):

a. Set the IP address to the value your local IT administrator supplies.

b. Set the Default gateway address to the value used in Step 6 of “Configure the Test Instrument’s IP 
Address Manually” on page 2-6.

c. Set the Subnet mask to the value used in Step 8 of “Configure the Test Instrument’s IP Address 
Manually” on page 2-6.

8. If you are using DNS, then provide that information as well (that your network administrator provides).

9. Click OK.

10. Close all windows that are open.

11. Reboot both the computer and the test instrument.

12. Continue with “Configure MST” on page 2-13

Figure 2-18. Internet Protocol (TCP/IP) Properties Dialog

Notes

• For quick access to instruments, the connection drop-down list in the MST toolbar records 
the last ten units to which it was connected. Clicking an entry in this list directs MST to 
attempt to re-establish that connection.

• MST cannot, at this time, accommodate IPV6 addresses.
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Configure MST
This section provides instructions to connect MST with the IP address of the instrument.

1. Start MST.

2. In MST, click Connection>Enter IP Address.

3. The Enter IP Address dialog displays.

4. Enter the IP address of the test instrument as displayed in its Ethernet Editor Dialog box. This is the 
address whether manually entered or LAN DHCP assigned. 

5. Click OK. The Connect: Ethernet icon changes from red 

to green when connection is established. 

Figure 2-19. Preparing to enter the IP address of the instrument.

Figure 2-20. Entering the IP address of the instrument.

Note For quick access, the connection drop-down list in the MST toolbar keeps a history of the last ten 
addresses that it connected to. Click an entry to tell MST to try to reconnect to that address.
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With the Status Bar turned on, a message at the bottom displays a Connected to message when communication 
is established. 

An alternative way of connecting to a device is to double-click the matching IP address of a test instrument to 
establish a connection to that test instrument. If the connection was made by selecting from the Network list, 
the message in the Status Bar is slightly different:

Direct Ethernet Crossover Cable Connection
Use an Ethernet crossover cable to connect directly between the computer and the test instrument. Then set 
the test instrument’s IP address and the computer’s IP address to use this basic Ethernet connection.

Configure the Instrument’s IP Address 

To configure an instrument’s IP address manually:

1. On the test instrument, press the Shift key, then the System [8] key. The test instrument’s System menu 
displays.

Figure 2-21. Direct Ethernet Connection Setup

Note

The IP address and the Gateway and Subnet masks in the following figure are examples only. 
Request address information from your IT administrator.
If the Ethernet Editor window does not display, this is because your instrument does not support an 
Ethernet connection; in this case try connecting with a USB or serial cable.

BTS Ethernet Port

Ethernet Crossover Cable
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2. Press the System Options soft key, The Ethernet Editor displays and the Ethernet menu displays along 
the right side of the instrument display.

3. Press the Type soft key to select Manual (it shows as underscored). The cursor moves to the IP address 
row and the First Octet field.

4. Set the IP address to 10.0.0.2 or to the address your local IT administrator supplies. This address will be 
used in MST to complete the connection (see Step 14 on page 2-19). Use the number keypad, the up/down 
arrow keys, or the rotary knob to change the value in the octet field. After a value is entered in the First 
Octet field, use the Octet soft keys, see Figure 2-24, or the left/right arrow keys to move to the next octet 
field.

Figure 2-22. Ethernet Editor Dialog

Figure 2-23. Type Soft Key

Figure 2-24. Octet Soft Keys

First Octet Second Octet Third Octet Fourth Octet
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5. Press the Field soft key so that G-Way is underscored. The cursor moves to the First Octet field of the 
Gateway address row. 

6. Set the Gateway address to 10.167.0.1 or to the address your local IT administrator supplies. Use the 
number keypad, the up/down arrow keys, or the rotary knob to change the value in the Octet field. After 
the value is entered in the First Octet field, use the Octet soft keys, see Figure 2-24, or the left/right 
arrow keys to move to the next and subsequent Octet fields.

7. Press the Field soft key so that Sub is underscored. The cursor moves to the First Octet field of the 
Subnet address row. 

8. Set the Subnet address to 255.255.255.0. Use the number keypad, the up/down arrow keys, or the rotary 
knob to change the value in the octet field. After the value is entered the First Octet field, use the Octet 
soft keys, see Figure 2-24, or the left/right arrow keys to move to the next and subsequent Octet fields.

9. Press Enter to accept the changes or Esc to discard.

Configure the Computer’s IP Address 
1. On the computer, go to the Ethernet Settings dialog.

2. Click Ethernet.

3. Click Change adapter options.

Figure 2-25. Field Soft Key: G Way Underscored

Figure 2-26. Field Soft Key: Sub Underscored

Figure 2-27. Windows Network Connections Selection
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4. The Network Connections dialog displays. 

5. Double-click Ethernet Unidentified network. The Ethernet Status dialog displays.

6. Click Properties. 

Figure 2-28. Choosing Ethernet from Network Connections

Figure 2-29. Ethernet Status Dialog
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7. The Ethernet Properties dialog displays. 

8. Select Internet Protocol Version 4 (TCP/IP v4) and click Properties. 

Figure 2-30. Ethernet Properties: Networking Dialog
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9. The Internet Protocol Version 4 (TCP/IPv4) Properties dialog displays. 

10. Click the Use the following IP address: button and enter the IP, Subnet mask, and Default gateway 
information (that your network administrator provides):

a. Set the IP address to the value your local IT administrator supplies.

b. Set the Default gateway address to the value used in Step 6 of “Configure the Test Instrument’s IP 
Address Manually” on page 2-6.

c. Set the Subnet mask to the value used in Step 8 of “Configure the Test Instrument’s IP Address 
Manually” on page 2-6.

11. (Optional) Click Use the following DNS server addresses and input addresses. This example leaves them 
blank.

12. Click OK.

13. Close all windows that are open.

14.  Return to MST 

15. Input the IP address from Step 2 on page 2-15.

Figure 2-31. TCPIP Properties

Notes

• For quick access to instruments, the connection drop-down list in the MST toolbar records 
the last ten units to which it was connected. Clicking an entry in this list directs MST to 
attempt to re-establish that connection.

• MST cannot, at this time, accommodate IPV6 addresses.
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16. Check the connection in the Connection drop-down and by capturing a measurement.

If it is not connected: 

a. Ensure the instrument’s IP address is the same as inputted in Step 2 on page 2-15 and let MST try 
to connect.

b. If still not connected, you might have to reboot the computer, the instrument, and/or MST.

Figure 2-32. Crossover Cable Connection Confirmation
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2-5 Connection and Configuration with Other Methods
This section describes how to connect these–BTS Master, Cell Master, and Spectrum Master –Master series 
instruments to MST using the non-LAN connection methods listed in “Connection Methods”.

USB Connection and Configuration
Use the USB cable supplied with the test instrument to make this connection.

1. Connect the USB cable between the USB Type-A connector on the computer and the USB Type-B 
connector on the test instrument.

2. Turn on the test instrument. Wait for it to display a measurement. 

3. Run the MST on the computer.

4. From the MST pull-down on the Connection menu, click Connect - USB. This establishes communication 
to the test instrument.

In the Toolbar, the Connect/Disconnect pull-down menu displays USB and the connector icon turns 
green. Disconnecting the cable or through software turns the connector icon red.

Figure 2-34, “USB Connection Message” shows the message that the instrument is connected also 
displays on the Status bar located at the bottom left corner of the MST application window.

Note Use Anritsu’s Line Sweep Tool to do the same tasks with Site Master. For complete information, visit:
www.anritsu.com/en-US/test-measurement/products/lst .

Figure 2-33. USB Connection Setup

Figure 2-34. USB Connection Message
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Serial Connections and Configuration

Serial-to-Serial Connection
Use the RS232 Serial cable supplied with the test instrument to make this connection. 

1. Connect the RS232 Serial cable between the RS232 Serial connector on the computer and the Serial 
Interface connector on the test instrument.

2. Turn on the test instrument. Run the MST program on the computer.

3. Go to “Configure the Computer for Serial Connections” on page 2-25.

Serial-to-USB Connection
This setup uses an RS232 Serial cable with an RS232-to-USB Adapter cable to connect between the test 
instrument and a computer. (Contact Anritsu customer service and ask for part number 551-1691.) This 
requires installing the software drivers for the RS232 to USB Adapter first and then configuring the COM port 
settings for computer.  

Figure 2-35. Serial Connection Setup

Figure 2-36. Serial to USB Connection Setup
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To install the Serial-to-USB Adapter software: 

1. Connect the RS232 cable from the device to the Serial-to-USB adapter and the adapter to the computer.

2. Place the Serial-to-USB Configuration Adapter CD into the computer’s CD/DVD drive.

3. Connect the USB end of the USB/Serial adapter into the computer.

4. If the installation software does not automatically start, bring up File Explorer and navigate to the 
Windows folder. 

5. Double-click to start the install program. The Installation wizard displays.

6. Click Next.

Note The images you see and steps you use might be different depending upon the adapter you install.

Figure 2-37. Serial-to-USB Driver Installer Program

Figure 2-38. Hardware Wizard Dialog
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7. The progress window displays. 

8. When the software installation completes, this window displays.

9. Press the Finish button. Continue with “Configure the Computer for Serial Connections” on page 2-25. 

Figure 2-39. Driver Installation Progress

Figure 2-40. Completing Hardware Installation
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Configure the Computer for Serial Connections

1. Press the Start button. Search for Settings and click Bluetooth and other devices.

2. Click Device Manager to bring up the Device Manager window. 

3. Double-click the communications port (COMn) to display Communications Port (COMn) Properties.

Note
The images presented in this section might be different from those you see, depending upon the 
release of Windows installed on your machine. Use the COM port configured for your connection 
type.

Figure 2-41. Computer Setup

Figure 2-42. Hardware Setup

Figure 2-43. COMn Port Setup
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4. Click the Port Settings tag and make sure that all the parameters are exactly the same as those expected 
by MST for this port. See “Configure MST” on page 2-27. (Use the highest BAUD rate that the 
connection will support.) 

5. Click OK to return to the Device Manager window.

6. Select Communications Port (COMn). 

7. Press right mouse button.

8. Click Scan for hardware changes. 

Figure 2-44. Port Settings: Computer (left); MST (right)

Figure 2-45. Com Port Setup

Note You might need to reboot the computer or laptop in order for Windows to see the new port.
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9. The Device Manager window updates the COMn port settings. You can close Device Manager.

10. Continue with “Configure MST” on page 2-27.

Configure MST
1. Power on the instrument.

2. Connect the male connector of the USB Serial Adapter to the female connector of the serial cable 
attached to the test instrument (if this connection not already established).

3. Start MST.

4. Click Program Options under the Tools menu. The Program Options window opens.

5. Click the Serial Port Settings tab.

6. From the Active Port pull-down menu, click the COM that supports the connection mode: Serial cable or 
Serial-to-USB cable. 

7. Then set the Baud Rate to the same as what was established in the Device Manager for that port. 

Figure 2-46. Available Serial Ports

Figure 2-47. Program Options: Serial Port and Baud Rate Settings
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8. Press the OK button.

9. Continue with “Test the Serial Connection to the Instrument” on page 2-28.

Test the Serial Connection to the Instrument
1. Click Connect – Serial (RS232): COMx in the Connection menu. Note the command line is checked and 

grayed. The connection list menu displays SERIAL and the connector symbol turns green.

2. The Status line of the MST display should show a status similar to this graphic:

3. Click the Capture Measurement button, on the toolbar. If MST captures the display screen from the 
instrument and displays it in the active measurement space in MST, connection testing shows a good 
connection and the test is complete.

Figure 2-48. Connection Menu: Serial Connection

Figure 2-49. Serial Status Message
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Chapter 3 — Graphical User Interface (GUI)

3-1 Introduction
This chapter defines and describes the MST graphical user interface (GUI) to operate MST and view the 
measurement files and other data obtained through it. 

3-2 Main Screen
The main screen displays the MST operational features. Opening the main screen provides the Menu Bar, 
Toolbar, context menus, edit menus, and measurement panels.

Figure 3-1. MST Graphical User Interface



3-2 Main Screen Graphical User Interface (GUI)

3-2 PN: 10580-00439  Rev. B Master Software Tools UG

Window Description

Main Menu Contains the menus - File, View, Sync, Tools, Window, Mode, and Help.

Toolbar
Displays tool icons used for file management, instrument connectivity, and trace 
management.

File Resource Tabs Use to select the source of the measurement file to be displayed

File Resource Directory 
Window Displays the directory and folder of the measurement file displayed.

File List Window Displays the content of the folder.

Measurement File 
Preview and Summary 

Window
Allows you to select a thumbnail view of the measurement or file summary.

Status Bar Displays connection and measurement file information.

Trace Catalog Toolbar Tools to manage the measurement files.

Appearance Toolbar Tools to edit the measurement files.

Active Measurement 
Pane Displays the measurements captured from instruments.

Active Measurement 
Captures The measurements as captured from instruments.
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3-3 Menu Bar

File
Opens a list of file management commands. Open, Save, Save As, Print command lines are standard file 
management commands.

Save All: Saves changes to all open measurement window panels in the Active Measurement window and 
any Master Software Tool supported files that are open, being edited, or being created, such as .spa, .vna, 
.txt, .png, etc.

Close All: Closes the measurement window panels and any Master Software Tool supported files that are 
open, being edited or being created, such as .spa, .vna, .txt, etc. If Remote Access Tools is open, it is also 
closed.

Export CSV: Outputs the current Active Measurement data to a Comma Separated Value formatted file. 
This text based format is supported by Microsoft Excel and most spreadsheet programs.

Export s2p: (For VNA measurement files only). Exports the current file to S2P file format. S2P files are 
ASCII text files that can be viewed or edited in any standard text editor.

Figure 3-2. MST Menu Bar

Figure 3-3. File Menus showing export differences
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Create Report: Creates a report from the current Active Measurement displayed. Refer to “Report 
Generator” on page 3-50  and to “Reports (.pdf and .html)” on page 5-4 for more information about 
generating reports.

Save JPEG: Saves the currently displayed Active Measurement as a JPEG file.

Save Folder as CSVs: Creates CSV files from all the measurements in selected folder.

Save Folder as JPEGs: Creates a JPEG image from all measurements in a selected folder.

Save Folder as DAT: Converts selected VNA or SPA files into DAT files and stores them in the selected 
folder.

Print All: Opens the Print All Measurement window. If Remote Access Tools is open, it will not be printed 
along with the other measurement window panels.

Exit: Closes all open measurement window panels, disconnects any instrument connected to the MST 
program, and exits MST.

The following commands are only available in the File menu when the Language Editor or Signal Standard 
Editor windows is the active window panel in the Active Measurement Pane.

Load ZNC file for comparison F10: When the Language Editor is open, this command loads ZNC files to 
compare to an existing ZNC file and add new words into the current file and load it into the instrument.

Figure 3-4. Generated Report Sample
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Load CSV file for comparison F10: When the Language Editor is open, this command loads CSV files to 
compare to an existing CSV file and add new words into the current file.

New: Opens a sub-menu for creating or editing MST-related files. 

Antenna File: Opens the Antenna Editor window for creating a new antenna list.

Cable File: Opens the Cable Editor window to create a new cable list.

Signal Standard File: Opens the Signal Standard Editor window.

Pass/Fail File: Opens the Pass/Fail Editor after downloading the file from the test instrument or 
after dragging a Test Models list file into the Active Measurement Window. This editor is used for 
editing the these Pass/Fail file types: GSM/EDGE/GPRS, WCDMA/HSDPA, Fixed WiMAX, Mobile 
WiMAX, CDMA, EV-DO, TD-SCDMA, LTE, and TD-LTE. Click the type of Pass/Fail file to be 
created and the Pass/Fail Editor window opens.

Figure 3-5. Generated Report Sample

Figure 3-6. Signal Standard Editor

Figure 3-7. Pass/Fail File Types
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Script Master: Lists a submenu to select a measurement file type to be created or edited. File types 
include GSM/WCDMA files or Channel Scanner files. 

Folder Spectrogram: Creates a Spectrogram from the selected folder of measurement traces.

Measurement Map: Opens the Measurement Map window.

Mobile WiMAX Parameter File: Opens the XML Parameter File Editor.

ISDB-T Filter File: Opens the Filter Editor for editing and creating ISDB-T filters. Refer to “Filter 
Editor for ISDB-T (*.isdb)” on page 5-18.

Edit 
The Edit menu is available only when the Language Editor or Signal Standard Editor windows is the active 
window panel in the Active Measurement Window. Click the desired file type and the Script Master window 
opens.

Language Editor-Edit Entry: Highlights the foreign language word for editing.

Language Editor-Find Text: Opens an entry widow to search for an English word.

Language Editor-Find Next: Continues the search for the word entered in Find Text.

Language Editor-Copy English Text: Copies the English text from column 2 to column 1.

Language Editor-Copy Comparison Text: Copy Compare string (3rd column) to translation (1st column).

Language Editor-Merge Translation: Merges the new language entries into the current Language file.

Add Signal Standard: Adds a new signal standard at the bottom of the list to be edited.

Delete Signal Standard: Deletes the signal standard currently highlighted.

Add Segment: Adds a segment to the currently highlighted signal standard.

Delete Segment: Deletes the highlighted segment from the current signal standard.

Figure 3-8. Edit Menu for Language Editor of *.znc Files

Figure 3-9. Edit Menu for Signal Standard Editor
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View
Command lines for Trace Catalog, Measurement Preview/Summary Window, Toolbar and Status Bar are 
toggle switches to display or not to display those items. Additional command lines are listed when specific 
windows are active in the Active Measurement Window.

Network Unit Summary: Shows a summary of test instrument options when a unit is selected from the 
Network list (the list of units is available over an active Ethernet connection).

Language Editor
Language Editor Commands are listed only when the Language Editor is the current active window 
panel.

Language Editor-Font Selection: Opens the Font window to change the font style of the highlighted text.

Language Editor-Toggle Color Coding: Toggles the color coding of the Language Editor page on and off.

Language Editor Function Key Summary: Opens a list of Function Key definitions.

Figure 3-10. View Menu

Figure 3-11. View Menu with the Signal Editor as the Active Window
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Signal Standard
Signal Standard Editor Commands are listed only when the Signal Standard Editor is the current active 
window panel.

Expand All: Expands the list of signal standards and their subsequent segments.

Collapse All: Collapses the signal standards list and segments to only show Signal Standards.

Connection 
This menu is used for setting up communication to a computer via USB or Ethernet.

Connect-USB: Initiates communication between the test instrument and computer via a USB connection. 
(USB to USB).

Connect-Ethernet: Initiates communication between the test instrument and computer via an Ethernet 
connection. 

Connect-Serial (RS232): Initiates communication between test instruments with serial ports to the 
computer. (Serial-to-Serial or USB-to-Serial).

Disconnect: Disconnects any communication between the test instrument and computer. 

Enter IP Address: Opens the input window to enter the IP address of the test instrument.

Refresh Network List: Refreshes the Network Device list. This is a list of Anritsu test instruments visible 
on the LAN. The Query Network for Instruments button accomplishes the same function.

Figure 3-12. Signal Standards View Menu

Figure 3-13. Connection Menu

Figure 3-14. Address Entry Window
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Sync
This menu contains commands to manipulate data files between the test instrument and the computer.

Upload Active Window: Copies the measurement data from the Active Measurement window panel to the 
internal memory of the test instrument.

File Transfer: Opens the Transfer Files to Handheld Device.

Upload Folder: Opens the Upload Files to Handheld Device window. 

Capture Current Measurement: Downloads the measurement data and screen display currently on the 
test instrument to MST and creates a measurement screen display panel in the Active Measurement 
window.

Download File List: (File denotes any one of the commands highlighted in the green box in Figure 3-15, 
“Sync Menu”.) Downloads associated files from the instrument to be saved on the computer in the 
Anritsu MST folder.

Download All Measurements: Copies all files from the internal memory of the test instrument onto the 
Anritsu MST folder or a folder specified by the user. Note: There is a limit of 1001 files that are allowed 
to be downloaded at one time. 

For very large number of files that need to be copied from the instrument to the computer, Anritsu 
recommends a USB memory stick to transfer files from the instrument to the computer.

Figure 3-15. Sync Menu

Figure 3-16. Upload Files to Handheld Device Window
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Refresh Device Measurement List: Refreshes the list of saved measurements shown for the currently 
connected test instrument. 

Device Status and Options: Commands in this submenu allow access to the test instrument status data, to 
download Config file and upload License file, and to stop and start measurements. 

Tools
This menu contains various file management and test instrument commands.

Group Edit: Allows the changing of the measurement title, subtitles, and common features such as plot 
scaling, markers, and limit lines simultaneously on a large set of similar measurement files. 

Trace Rename Utility: Opens the MST Rename Utility to rename measurement traces. 

DAT File Conversion Tool: Opens the DAT File Conversion Tool window to convert legacy file types from 
Anritsu Handheld Software Tools (HST) format to the file format supported by MST. Refer to 
Figure 3-29, “DAT File Conversion Tool Window” on page 3-16.

Distance-To-Fault: Opens the DTF window to convert a VNA Return Loss file to a DTF-Return Loss file. 

Figure 3-17. Device Status and Options List

Figure 3-18. Tools Menu

Warning Conversion of a HHST data file to the MST data file is unidirectional; keep the old file for archives.
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Remote Access Tool (RAT): Opens a fully functional software emulator that remotely controls the 
connected test instrument. (This function requires an Ethernet connection.) 

Use the Settings link in the RAT window to set the refresh rate..

The Connection Settings dialogs displays. Use the up/down arrows to select a refresh rate.

Figure 3-19. Remote Access tool

Figure 3-20. Refresh Rate Menu

Figure 3-21. Refresh Rate Dialog
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Full Trace Retrieval: Similar to the command line Download All in the Sync menu, this function retrieves 
all files stored in the internal memory space of the connected instrument. This can be faster, especially 
on older instruments, than Download All but it requires an Ethernet connection. USB is not supported.

Measurement Calculator: This tool translates certain values into other units. It can show Real and 
Imaginary values, Magnitude, Phase, Return Loss, Reflection Coefficient, and Transmission Power. 
Enter a value in any field, and the other fields are adjusted automatically.

Product Updates: Opens the Product Updates window, used to update, repair, or recover files in the 
internal memory of the test instrument.

Program Options: Opens the Program Options window to set parameters for Program Elements, File 
Transfer and Confirmations, JPEG Save Options, Measurement Print Options, Report Generator and 
Internet Settings.

Window
This menu controls the open measurement window panels. Cascade, Tile Vertical, and Tile Horizontal organize 
the measurement panels in the Active Measurement window. Measurement panels open in the Active 
Measurement window are listed beneath the Close All command. The currently active window panel is checked 
in this menu.

Cascade: Stacks the window panels diagonally, layered one on top of the other. 

Tile Vertical: Places the window panels one above the other. 

Tile Horizontal: Places the measurement window panels side by side. 

Print All: Opens the Print All Measurements window. If Remote Access Tools is open, it will not be printed 
along with the other measurement window panels.

Close All: Closes the measurement window panels and any Master Software Tool supported files that are 
open, being edited or being created, such as .spa, .vna, .txt, etc. If the Remote Access Tool is open, it too is 
closed.

Note
Anritsu recommends using the most recent remote access software Wireless Remote Access Tool. 
Go to the Anritsu Website to download this software:
https://www.anritsu.com/en-us/test-measurement/products/wrt

Figure 3-22. Window Menu
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Help 
Help Contents: Opens the Master Software Tools User Guide (this guide) in the Adobe Acrobat Reader (if 
the Reader is installed on the computer).

Contacting Anritsu Customer Support: Opens the Contacting Anritsu window with information on 
contacting Anritsu Customer Support. 

Anritsu on the Web: Click this web link go to the Anritsu Customer Support Internet site.

About Master Software Tools: Opens the About MST window that displays the current version of software 
and copyright information. 

Figure 3-23. Help Menu

Figure 3-24. Anritsu Contact Window

Figure 3-25. MST Version and Copyright Window
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3-4 Toolbar
This graphic shows the main toolbar for MST. The tools are described from left to right

Open File: Opens the Open Measurement File window to load a measurement file into MST.

Save File: Saves the data from the active measurement window panel to file.

Save All: Saves changes to all open measurement window panels in the Active Measurement window and 
any MST-supported files that are open, being edited or being created, such as: .spa, .vna, .txt, etc.

Figure 3-26. Main MST Toolbar

Figure 3-27. Open Measurement File Window
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Report Generator: Generates a report from the Active Measurement window panel. See “Reports (.pdf 
and .html)” on page 5-4 for more about reports.

Print Report: Generates a report from the Active Measurement window panel then prints it.

Connect/Disconnect: Initiates communication between the computer and test instrument. The 
communication type displays. After both systems handshake, the connector turns green.

Refresh Device Measurement List: Refreshes the list of saved measurements shown for the test 
instrument connected.

Upload Measurement: Uploads all measurement window panel data to the connected test instrument as 
files.

Capture Current Measurement: Downloads the measurement data and screen display currently on the 
connected instrument to MST and creates a measurement screen display panel in the Active 
Measurement window.

Figure 3-28. Generated Report Sample
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Launch the DAT File Conversion Tool: Opens the DAT File Conversion Tool window. Converts supported 
file types from Anritsu Handheld Software Tools format to the file format supported by MST. The 
DAT-to-MST file conversion is irreversible.

Open the Remote Access Tool Window: Runs the Remote Access Tools program. 

Figure 3-29. DAT File Conversion Tool Window

Note
Anritsu recommends using the most recent remote access software Wireless Remote Access Tool. 
Go to the Anritsu Website to download this software:
https://www.anritsu.com/en-us/test-measurement/products/wrt
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3-5 Graphic Display Edit Toolbar
This graphic shows the tools available for the Active Measurement display window. The tools are described 
from left to right.

Mouse Function: Opens a menu that controls the function of the mouse while in the Active Measurement 
window. The label on the toolbar button for the mouse function changes to indicate which of the four functions 
has been selected by appending the function title after the word mouse. For example, when Position is selected, 
the button label changes to Mouse: Position. The drag overlay function is abbreviated as Mouse: Overlay.

Position: Displays the x and y coordinates of the graph in Frequency and Amplitude. For DTF 
measurements, Distance and Amplitude values are displayed. Drag the mouse while holding the left 
mouse button and the coordinate display will indicate changing measurement values as the mouse 
position changes. 

Distance: Displays the difference in frequency between two points. Click when moved horizontally from 
the original start point, or the difference in Amplitude when moved vertically from the original start 
point.

Zoom: Expands the selected section of the graph for closer analysis of a trace. (Default)

Histogram: When editing scope files, the Histogram function replaces Zoom. In this mode, a rectangular 
histogram can be drawn on the active measurement panel.

Drag Overlay: Grabs a trace from a similar type graph and places it on the desired graph. 

Autoscale: Expands the vertical scale to spread the measurement over 70% to 80% of the active measurement 
window panel. This reduces the number of horizontal graticule lines by an amount that depends upon the 
vertical spread of the measurement being auto-scaled.

Undo Zoom: Returns the graph to its original view.

Overlays: Toggles any overlaid traces on the Active Measurement window panel on and off.

Figure 3-30. Graphics Display Editor Toolbar

Figure 3-31. Mouse Functions Pull-down Menu
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Edit Graph: Opens the Plot Setup dialog associated with the active measurement window panel.

Markers: Lists the marker table under the active measurement graph for selecting and setting up markers. 
Clicking the pull-down menu opens a sub-menu to set a Marker To Peak, set a Marker To Valley, set a marker 
to Peak Between Markers, or set a marker to Valley Between Markers. Highlighting either Marker To Peak or 
Marker To Valley opens another sub-menu to select a marker. Peak Between Markers and Valley Between 
Markers lists a sub-menu of markers to position between a maker pair. 

Active Trace: Displays a list that allows you to choose between traces.

Figure 3-32. Sample Plot Setup Window

Figure 3-33. Markers Pull-down Menu
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3-6 Active Measurement Window
The is the display space for all active measurement panels. A new active measurement panel is placed in front 
of other panels and its title bar is highlighted a darker color.

3-7 File Resource Group
This group of controls, governed by the File Resource tabs, includes the Device File Resource window, the Open 
File List window, and the Network window, they display information about the resources available to MST.

Note TD-SCDMA Signal Analyzer measurement panel cannot be saved nor displayed through MST 
except as a .JPG file.

Figure 3-34. Active Measurement Window

Figure 3-35. File Resource Tabs
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Local File Resource Directory Window
When the Local tab is clicked, the File List window displays a list of measurement files stored on the computer.

Device File List Window
When Device tab is clicked, the Device File List window shows a list of measurement files available to MST 
from the instrument’s internal memory, from a compact flash card, or USB memory attached to the 
instrument.

Open File List Window
When the Open tab is clicked, this window shows the list of files that are currently open in the Active 
Measurement window. 

Figure 3-36. File List Window showing Local File Resource directory 

Figure 3-37. File List Window showing internal files on an instrument

Figure 3-38. File List Window--showing open files in Active Measurement window
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Network Window
When the Network tab is clicked, this window shows the list of instruments that are currently available 
through the LAN. 

3-8 Measurement Preview/File Summary Windows
When a file in the File List window is highlighted, its trace data displays in graphical format when the Preview 
tab is clicked or its metadata displays when the File Summary tab is clicked. Use the View>Measurement 
Preview/Summary Window main menu choice to hide or show this window. 

3-9 Status Bar
The Status Bar displays information about the connection from MST to the instrument showing the type of 
connection used, the number of measurement files in the instrument (Remote Count), and how long MST and 
the instrument have been connected.

Figure 3-39. File List Window--showing open files in Active Measurement window

Figure 3-40. Measurement File Preview/Summary Window

Figure 3-41. Status Bar
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3-10 Context Menus & Plot Setup
Context Menus are menus that open when you place the mouse cursor over an active measurement panel and 
right-click. 

There are common command lines and plot setup options in the context menus of several analyzers and 
editors. For specific options not included here, refer to the section of this User Guide specific to the 
measurement of interest.

Common Context Menu Command Lines and Plot Setup Configurations 
Right-click on a measurement panel to bring up the context menu.

Data Display Options: Displays the Plot Setup dialog. 

Figure 3-42. Example Context Menu

Figure 3-43. Example Plot Setup dialog
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Data Markers: Opens a list of marker commands. 

Display Marker Table: Displays a Table of Markers underneath the graphical display.

Compress Marker Table: Compresses the marker table to display only used Markers. Markers not 
in use or invisible are not shown.

Markers Snap to Data: When enabled, dragging a marker moves from a data point to the next data 
point. When disabled, dragging the marker allows movement between data points on the line. 

Show Marker Numbers: Displays the sequence number of the Marker when initially added. 

Marker 1 Reference: Sets Marker 1 as a reference to the six delta markers. 

Move Deltas with Reference: Enables the six delta markers to move with Marker 1. 

Reset Marker Positions: If moved, resets all markers to their original positions. 

Vertical Line: Toggles the Marker to show as a vertical line instead of an inverted triangle. 

Inverted Triangle: Toggles the Marker to show as an inverted triangle instead of a vertical line. 

View Limit Lines: Opens a list of Limit Line controls. Many measurement types support upper and lower 
limit lines on data plots. In the Plot Setup dialog box, the limit lines can be turned on or off (upper and 
lower separately) and can be reset to specified values. When a limit line is reset, it is reduced to two 
nodes spanning 90% of the x-axis range and is set above or below the vertical data range. A special 
context menu is associated with each node in a limit line. 

Show Upper Limit Line: Toggles the Upper Limit Line on and off. 

Show Lower Limit Line: Toggles the Lower Limit Line on and off. 

Figure 3-44. Data Markers Pull-down Menu

Figure 3-45. View Limit Line Controls Menu
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Annotations: Opens a sub-menu to manage notes on the Active Measurement Window Panel list. 

Add New Note: Allows placement of notes on the Active Measurement Window Panel. Notes are 
displayed as text in yellow rectangles, as shown below.

Edit Selected Note: Opens the Note Entry window to edit the message in the Note and show or hide 
the frequency and power values.

Hide Selected Note: Hides the currently selected Note.

Delete Selected Note: Deletes the currently selected Note. 

Figure 3-46. Annotation Controls Menu

Figure 3-47. Active Measurement Window Panel with Annotations

Figure 3-48. Annotation Entry Window and the effect of Show Frequency & Power 



Graphical User Interface (GUI) 3-10 Context Menus & Plot Setup

Master Software Tools UG PN: 10580-00439  Rev. B 3-25

Show All Notes: Displays all hidden Notes. 

Mouse Function: Opens a list of mouse functions. These commands are also accessible by clicking the 
Mouse: menu on the Graphic Toolbar.

The label on the toolbar button for the mouse function displays which of the four functions is selected by 
appending the function title after the word Mouse. For example, when Position is selected, the button 
label changes to Mouse: Position.

Position: Displays the x and y coordinates of the graph in Frequency and Amplitude. For DTF 
measurements, Distance and Amplitude values are displayed. Drag the mouse while holding the 
left mouse button and the coordinate display will indicate changing measurement values as the 
mouse position changes. 

Distance: Displays the absolute value of the difference in Frequency when the mouse pointer is 
clicked and dragged horizontally from a starting point, or the difference in Amplitude when clicked 
and dragged vertically from a starting point.

Zoom: Expands a selected section of the graph. Use this feature for closer analysis of a trace. Use 
Cntl+U, or the Undo Zoom command on page 3-27.

Drag Overlay: Grabs a trace from a similar type graph and places it on the desired graph. 

Text Size: Opens a menu to change the text size of the Active Measurement Window. The default text size 
can be adjusted for all measurement windows. If a window is reduced to a size that is too small for the 
selected text size, the text size is automatically reduced, but is automatically enlarged again to the 
selected value if the window is enlarged sufficiently.

Figure 3-49. Mouse Function Menu

Figure 3-50. Mouse Functions Menu

Figure 3-51. Text Size Selection
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Clipboard: Opens a sub-menu of copy commands.

Copy Measurement (Bitmap): Copies a bitmap of the graph in the active measurement screen to the 
clipboard. 

Copy All Measurement Data (Text): Copies the data of the active measurement window panel to the 
clipboard in .txt file format.

File: Opens a list of file management and edit commands.

Save Data File: Save the current measurement with the appropriate file type.

Save JPEG: Saves the currently displayed Active Measurement as a JPEG file.

Export to CSV: Saves the data file as a CSV (comma-separated values) file that can be imported 
into a spreadsheet application. 

Print: Sends the active measurement window graph and data to the printer.

Edit Main Title: Opens the Enter Title entry dialog to change the main title of the active 
measurement window.

Figure 3-52. Copy to Clipboard Functions

Figure 3-53. File Management Window

Figure 3-54. Enter Title Entry Window
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Edit Measurement Title: Opens the Enter Subtitle entry dialog to change the subtitle of the active 
measurement window. 

Edit Operator Name: Opens the Edit Operator Name dialog. Type the name, press OK or press 
Cancel.

Edit Tower Name: Opens the Edit Tower Name dialog. Type the name, press OK or press Cancel.

Undo Zoom: Undoes the previous zoom operation.

Figure 3-55. Enter Subtitle Entry Window

Figure 3-56. Enter Operator Name

Figure 3-57. Enter Tower Name
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Spectrum Analyzer (SPA) 

Data Display Options: Opens this version of the Plot Setup dialog.

Figure 3-58. Spectrum Analyzer Context Menu

Figure 3-59. Spectrum Analyzer Plot Setup Dialog: Data Display Options
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Cable and Antenna Analyzer (Vector Network Analyzer - VNA)
Opens a sub-menu to edit the Limit Lines and Markers.

Data Display Mode (Vector Network Analyzer): Opens this version of the Plot Setup dialog: 

Expand Current Plot (Vector Network Analyzer): If the current VNA graph contains four views, one of 
them can be expanded by clicking this command. 

WCDMA 
The Plot Setup from the WCDMA context menu open a sub-menu to edit the Limit Lines.

Figure 3-60. VNA Context Menu

Figure 3-61. VNA Plot Setup Window

Figure 3-62. WCDMA Plot Setup Window
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Interference Analyzer (IA)
Opens a sub-menu to save an .IA file in different file formats. The measurement window shows a composite of 
all traces in a spectrogram. Each data set is shown as a single row of pixels with color variation to indicate 
amplitude. There is a cursor on the spectrogram that allows selection of a single line from the spectrogram 
which is then displayed as a normal trace below the spectrogram. In the image shown, the cursor is a red line 
at the very top of the spectrogram. Between the spectrogram and the individual trace graph is the number of 
the highlighted trace along with its date and time stamp. GPS and UTC data will be displayed for 
measurements taken with GPS and UTC data.

Figure 3-63. IA Measurement Editor

Figure 3-64. IA Context File Menu
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Export to CSV: Opens the Save As window to save the data file as a CSV (comma separated values) file 
that can be imported into a spreadsheet application.

Save Window as JPEG: Saves both the Spectrogram and the currently selected trace below it in a single 
JPEG image. 

Save Spectrum as JPEG: Saves only the selected trace in a normal x-y plot and does not include the 
spectrogram. In both cases, a table of measurement parameters is appended below the graph.

Figure 3-65. Active Measurement Window Saved as JPEG Sample

Figure 3-66. Active Measurement Spectrum Only Saved as JPEG Sample
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Create AVI: Opens the Create AVI dialog box to begin creation of the AVI.

Edit Title: Opens the Enter Title dialog box to enter a new title for the measurement. Press the OK button 
when done.

Edit SubTitle: Opens the Enter Subtitle dialog box to enter a new title for the measurement. Press the OK 
button when done.

3D Spectrogram View: Opens the Create AVI dialog box to begin creation of the AVI.

JPEG File
Opens a file management sub-menu.

Save As: Opens the Save As window to name and store the file.

Close: Closes the JPEG file.

Print: Prints the file as JPEG.

Copy to Clipboard: Copies the file to the clipboard so it can be pasted in other documents.

Limit Line Node
Opens a sub-menu to edit the Limit Lines.

Delete Node: Deletes the limit line node the cursor is on.

Add Node: Adds a node to the limit line.

Edit Node: Opens the Edit Limit Line Node entry box to change the Frequency and Power values.

Figure 3-67. Create AVI Dialog Box

Figure 3-68. JPEG File Management Controls

Figure 3-69. Limit Line Node Controls Context Menu
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Make Horizontal - Left: Changes the Power value of the highlighted node equal to the Power value of the 
node to its left.

Make Horizontal - Right: Changes the Power value of the highlighted node equal to the Power value of the 
node to its right.

Make Vertical - Left: Changes the Frequency value of the highlighted node equal to the Frequency value of 
the node to its left.

Make Vertical - Right: Changes the Frequency value of the highlighted node equal to the Frequency value 
of the node to its right.

Power Meter, High Accuracy Power Meter, Fixed WiMAX, Mobile WiMAX, WCDMA

Data Display Options (for Power Meter and High Accuracy Power Meter): Opens the Plot Setup window.

Data Display Options (Fixed WiMAX, Mobile WiMAX): Opens the dialog window to change the text size of 
the Fixed WiMAX and Mobile WiMAX Editor window.

Figure 3-70. Context Menu for Power Meter, Hi- Accuracy Power Meter, Fixed WiMAX, Mobile WiMAX, WCDMA

Figure 3-71. Power Meter and High Power Accuracy Meter Plot Setup Window

Figure 3-72. Fixed & Mobile WiMAX Plot Setup Window
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TD-SCDMA Signal Analyzer
Because the TD-SCDMA Signal Analyzer does not use Limit Line or Marker editing features, no context menu 
opens for this measurement type.

Channel Scanner
This context menu displays when clicking the right mouse button and the Plot Setup dialog displays when you 
click Data Display Options.

Figure 3-73. Channel Scanner Context Menu and Plot Setup dialog
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3-11 File Editors, Tools, and Other Miscellaneous Windows

Print All Measurements
Print All command only prints measurement files. Lists (antenna, cable, etc.), JPG and other 
non-measurement files are not printed. 

Page Layout: Select the number of plots from the Active Measurement Window to be printed per page. 

Page Orientation: Places the plot in a Portrait (vertical) or Landscape (horizontal) format. 

Printer: Select the printer to handle the printing of the measurement files.

x of y: States the number of measurement files x of y open files to be printed.

Print: Click Print to print files.

Antenna Editor
Opens immediately after downloading and saving a file from the test instrument or after dragging an Antenna 
List file into the Active Measurement Window. After an antenna list window is open, use Sync>Upload Active 
Window to upload the new antenna list to the instrument. The blank box in the Antennas column is for a new 
antenna entry. When highlighted, a row of blank boxes will appear in the window on the right. Enter the 
antenna’s Frequency (MHz), Antenna Factor (dB), and Antenna Gain (dBi) in the respective boxes.

Figure 3-74. Print All Measurements Window

Figure 3-75. Antenna Editor Window
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Cable Editor 
Opens immediately after downloading the file from the test instrument or after dragging a Cable List file into 
the Active Measurement Window. A row of blank boxes are available at the end of the list. Scroll down to these 
boxes. Enter the new cable name and associated parameters. 

Signal Standard Editor
Opens immediately after downloading the file from the test instrument or after dragging a .SIG file into the 
Active Measurement Window. This editor is used for editing signal standard file types – WCDMA, CDMA, 
GSM, No Uplink/Downlink, Fixed WiMAX, Mobile WiMAX, TD-SCDMA, and LTE. 

Figure 3-76. Cable Editor Window

Figure 3-77. Signal Standard Editor
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The context menu for list of Signal Standards.

Copy: Copies the highlighted signal or segment to the clipboard.

Cut: Removes the highlighted branch from the list of signal standards.

Paste: Pastes a signal from the clipboard under the highlighted signal branch. Adds the current segment 
in the clipboard to the list of segments in the highlighted signal branch.

Add Signal Standard: Adds a signal branch to be edited to the bottom of the list.

Delete Signal Standard: Deletes the highlighted signal standard.

Add Segment: Adds a segment branch under the highlighted signal standard.

Delete Segment: Deletes the highlighted segment standard.

Figure 3-78. Signal Standard Editor Context Menu
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Language Editor
Opens immediately after downloading the file from the test instrument and stores the file xxx.znc locally in 
C:\Program Files\Anritsu\Anritsu Master Software. The Language Editor allows for modification of the 
language that is already in the instrument (except English) and also provides the ability to add two custom 
languages to the instrument. 

Pass Fail Editor
Opens immediately after downloading the file from the test instrument or after dragging a Test Models list file 
into the Active Measurement Window. This editor edits these Pass/Fail file measurement types: 
GSM/GPRS/EDGE, WCDMA/HSDPA, Fixed WiMAX, Mobile WiMAX, CDMA, EV-DO, TD-SCDMA, TD-LTE, 
and LTE. The blank box in the Models column at the end of the list is for a new model entry. When highlighted, 
a row of blank boxes will appear in the window on the right. Enter the associated parameter in each box.

Figure 3-79. Language Editor Window

Figure 3-80. Pass/Fail Editor Window
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XML Parameter File Editor
Click File>New>Mobile WiMax Parameter File to open this dialog. Simple DL-MAP editor to edit current 
DL-MAP files or create DL-MAP files in MST. When editing or creating a file is completed, use the Upload 
button to transfer the file back into the instrument. For more information, please refer to the MX370105A 
Mobile WiMAX IQ producer documentation.

SPA and VNA Plot Setup: Common Settings
Right-click a .spa or .vna display in the measurement window and choose Data Display Options or Data Display 
Mode.

The Plot Setup dialog displays and use it for changing various plotting parameters.

Figure 3-81. XML Parameter File Editor

Figure 3-82. Spectrum Analyzer and Vector Network Analyzer Plot Setup
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Data Display Options
The Data Display Options tab contains parameters for plot scaling and marker and limit line settings

• Plot Scaling

Frequency: Enter the minimum and maximum frequency plot boundaries.

Amplitude: Enter the minimum and maximum amplitude plot boundaries.

Marker Table: Check this box to display the marker table below the graph.

• Marker and Limit Line settings

Marker Table: Turns on or off the marker table.

Markers: Toggles the markers to be displayed as inverted triangles or lines.

Upper Limit Line: Toggles the Upper Limit Line on or off in the active measurement window.

Lower Limit Line: Toggles the Lower Limit Line on or off in the active measurement window.

Reset: If the Limit Lines were moved, the Reset button returns the lines to their original value.

Text Size: Changes the text size in the active measurement window.

Figure 3-83. SPA and VNA Data Common Display Options
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Trace Math & Overlays Tab

Trace Math is a tool for comparing two traces. You can upload traces using MST, store those traces in memory, 
and compare the stored traces with a more recent trace.

• Overlay Traces

Add: Opens a .SPA or a .VNA File List dialog from which to select traces for overlaying.

Remove: Removes the selected trace from the current Overlay Traces window.

• Trace Math

Trace Math: When a second set of data is overlaid on a measurement trace, normally both data sets are 
displayed simultaneously, but in different colors. If Trace Math is active, then only a single trace is 
shown, and that single trace is either the sum or difference, taken point by point, of the original data set 
and the overlaid data set. There are three options for Trace Math: Trace + Overlay, Trace – Overlay, and 
Overlay – Trace.

Because up to five overlays can be active at once, trace math is always defined as being the original trace 
and the first overlay. The arrows in the Overlay dialog box move the overlays up and down in order, to 
select which of the five to use in trace math.

• Smoothing

Smooth Trace: Allows the user to smooth a trace by a percentage determined by the number in the box. 
The default is set to 1%.

Show Trace: Smoothing uses a moving average to even out bumps in the data trace. If Show Trace is 
selected, the original trace is shown in a faint color behind the ‘smoothed’ trace to show the effect of the 
smoothing.

Weighted: When smoothing a trace, the default is to use a square averaging window, meaning that the 
new value of a point will be the average value of X number of points to each side. A square window gives 
each point in the average the same weight, and is considered no weighting. If Weighting is checked, then 
adjacent data points are given more weight in the average than points further away.

Figure 3-84. SPA and VNA Data Display Options
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VNA Additional Plot Setup Settings
There are two additional tabs for VNA measurement files.

Plot Properties Tab

• Graph Boundaries: The following parameters dictate the boundaries of the plot. Parameters active for 
the file type are highlighted in black. Inactive parameters are grayed out. Adjust the boundaries by 
entering the Top and Bottom Limits of the plot.

For the S11 group:

VSWR 

Log Magnitude 

Phase 

Cable Loss 

Log Mag. Fault Location 

DTF VSWR 

Two Port Group Delay 

For the S21 group:

Log Magnitude 

Phase 

Group Delay 

• Distance Units:

Meter 

Feet 
Time (ns) 

• Group Delay:

Aperture 

Figure 3-85. VNA Plot Properties
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Exporting Tab:

• Select output options for CSV file export: 
The following are parameters that can be included in an exported CSV file. Check the desired 
parameters.

• Device Information 

• VNA Setup Parameters 

• Data Markers 

• Limit Lines 

• Measurement Data 

• S11 Real & Imaginary 

• S21 Real & Imaginary 

• S11 Magnitude and Phase 

• S21 Magnitude and Phase 

• Select output options for s2p file export: 
The following are parameters that may be included in an exported .s2p file. Check the desired 
parameters.

• Real & Imaginary 

• Magnitude & Phase 

• dB & Phase 

• Reference Impedence (Ohms) — choose 50 or 75 Ohms. 

Figure 3-86. VNA File Exporting Setup
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Power Meter and High Power Accuracy Meter Plot Setup

• Power Limits

• Show Limits: Select to show the Limits. Enter the values of the Lower and Upper Power Limits

• Lower (dBm)

• Upper (dBm)

• Meter Scaling: Enter the values of the Minimum and Maximum Scales of the Meter.

• Minimum (dBm)

• Maximum (dBm)

• Display Units: Select dBm, dBV, dBmV, dBuV, V or mW.

• Text Size: Changes the text size in the active measurement window.

• Meter Size (Degrees): Changes the arc angle of the meter.

Enter IP Address

Figure 3-87. Power Meter and High Power Accuracy Meter

Figure 3-88. IP Address Entry Box for Setting Up an Ethernet Connection
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Measurement Calculator (VNA) 
This Tools menu command translates certain values into other units. It can show: Real, Imaginary, Magnitude, 
Phase, Return Loss, Reflection Coefficient, and Transmission Power.

DAT File Conversion Tool
Converts supported file types from Anritsu Handheld Software Tools (HHST) format to the file format 
supported by MST. File conversion is one-way. Refer to Figure 3-29, “DAT File Conversion Tool Window” 
on page 3-16.

Distance-To-Fault
Converts RL and VSWR plots to DTF plots. 

Transmission Parameters: Select a coax cable, the waveguide, or a cable from the pull-down menu. 
Enter a dielectric constant and insertion loss values for cables not selected from the pull-down 
menu.

Data Format: Displays the plot type to be converted to DTF.

Figure 3-89. Measurement Calculator

Figure 3-90. DTF Window
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Range: Enter the start and stop distances of the measurement.

Units: Select the desired distance unit of measure – Meters or Feet.

Windowing: Select the type of windowing method to be used on the plot.

Trace Rename Utility
Utility window to rename measurement traces.

Figure 3-91. MST Rename Utility Window
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Product Updates
This feature is used to update MST and instrument software. Refer to Figure 6, “Advanced Features” 
on page 6-1 for complete information. 

3-12 Program Options
This window sets the parameters for General, Report Generator, Internet Settings, Serial Port Settings, and 
Languages.

The sections that follow describe the tabs in detail.

Figure 3-92. Product Updates Window

Figure 3-93. Tabs of the Program Options Window



3-12 Program Options Graphical User Interface (GUI)

3-48 PN: 10580-00439  Rev. B Master Software Tools UG

General Tab

• Program Elements

• Display Trace Preview/Summary – This window, on the bottom-left of the screen, can be toggled 
between showing the selected measurement and showing information about the file, such as File 
type, last saved, size, modified, and location on the network or hard drive.

• Display Network Unit Information – When browsing units on the network, this option displays the 
unit information in the File Summary window under the browser.

• Show Toolbar – This option allows displaying the toolbar in the top part of the display.

• Display Status Bar – This option allows displaying the status bar located at the very bottom of the 
MST window.

• JPEG Save Options

• Show Measurement Parameters – This option displays the following information as part of the JPG 
file: Trace mode, reference level offset, input attenuation, resolution bandwidth (RBW), video 
bandwidth (VBW), type of detection, start frequency, center frequency, stop frequency, frequency 
span, reference level, and scale.

• Show Device Parameters – This option displays information on the device that collected the data, 
including the serial number, base version, software version, when the data was taken, and the 
device name, if applicable.

• Invert Colors When Saving – This option inverts all of the colors, so black becomes white or yellow 
becomes blue, for better visibility and more economical printing.

• JPEG Quality – This option allows the user to select the quality level of JPEG images when stored.

• File Transfers & Confirmations

• Get Remote File List On Connect – When selected, MST automatically retrieves the file list when 
an instrument is selected. Some test instruments may have hundreds (or thousands) of stored 
traces, so selecting this option can slow access time when connecting and retrieving the device file 
list. If not selected, MST does not automatically retrieve information about the files on the test 
instrument.

Figure 3-94. Program Options Window Showing General Tab 
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• Automatically Save Remote Files – If this option is checked, files that are downloaded from the test 
instrument are automatically saved to the local hard drive and placed in the currently selected 
local directory.

• Confirm Download From the instrument – This option displays a message when the download has 
been completed.

• Confirm Upload From the instrument – This option displays a message when the upload has been 
completed.

• Confirm overwrite when uploading – This option displays a message when files that are uploaded to 
the test instrument are being overwritten.

• Measurement Print Options

• Print Measurement Parameters – When a measurement is displayed, relevant measurement 
parameters are shown in the File Summary box at the lower left-hand side of the application 
window. When this option is selected, this same measurement summary information is included in 
a table below the printed measurement. 

• Print Device Parameters – When selected, this option includes the following information on the 
print-out: test instrument serial number, base firmware version, applications firmware version, 
date and time that the measurement was saved, and the user-defined test instrument name.

• Default to Landscape Orientation – Printed measurements default to Landscape Orientation when 
this option is selected. This option must be changed in the Print Properties dialog box each time 
that a measurement is printed. This selection affects only the default setting in this dialog box.

• Remember Printer Selection – This option enables MST to remember previous printer selections. 
Otherwise, the system default printer is automatically selected. If a preferred printer is desired for 
MST (other than the system default printer) this option allows that printer to be the default for 
this application only.

• MapPoint Region

Measurements that contain GPS location information can be displayed with Microsoft MapPoint 
in MST. When a map window is initially opened, any measurements that contain GPS data and 
are currently open are automatically placed on the map. The measurement is placed at the 
geographic location on the map that is indicated by the GPS data. Microsoft MapPoint must be 
purchased separately. Choices are: North America or Europe.

• Mouse Mode Settings

Apply Mouse Mode to All Windows – When selected, this option applies the current mouse mode to 
all open windows. When the mouse mode is changed (for instance, from position to distance) in any 
open measurement window, that change can be applied to any open window with this option. If 
this option is set to off, then each measurement window can have a different mouse mode setting.

• Change Child Window 

Check the Change Child Window Size box and set Width and Height parameters to establish the 
default size for child windows displayed in the Measurement Window space.
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Report Generator
The Report Generator facility is covered in detail in “Reports (.pdf and .html)” on page 5-4.

• Report Header 
The Report Header section controls the these features on the report:

• Report Title 

• Company 

• Prepared For 
• Location 

• Date & Time 

• Company Logo: Click the folder button to display a file browser, to locate the logo file.

• Logo Align (left-, right-, or center- aligned)

• Open With

• Default Editor (Microsoft Word, FrontPage, etc.)

• Default Viewer (Internet Explorer, Chrome, etc.)

• Other (User Specified) Click the folder button, which engages a file browser, to find the appropriate 
application, or enter the full path.

• Signature Line 
This option appends the requested signature lines.

• Prepared By 

• Approved By 

• Output Format
Select the file type to be generated.

• PDF 

• HTML 

Figure 3-95. Program Options Window with the Report Generator Tab Selected
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Internet Settings

• Automatic Update Notification

This option automatically checks for updates from the Anritsu Product Support Internet site.

• Proxy Settings

Use a Proxy Server to access Internet content. If Internet access is through a proxy server, then a 
user-name, password, and domain are required. This information is generally available from the system 
administrator.

Serial Port Settings
These settings are used for Serial-to-Serial and for USB-to-Serial connections. See “Serial-to-Serial 
Connection” on page 2-22 and “Serial-to-USB Connection” on page 2-22 for more information.

• Active Port

Pull down this menu to select the COM port that you set up in the Systems of the Control Panel to 
communicate with the Anritsu test instrument.

• Baud Rate

Set the baud rate to 115200. If you have problems with communications between MST and the test 
instrument, then lower the baud rate to the next speed.

Figure 3-96. Program Options Window with the Internet Settings Tab Selected

Figure 3-97. Program Options Window with the Internet Settings Tab Selected
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Languages

This window allows you to set the language font style in MST for window titles, menu titles, command lines, 
and options lists. The list of language fonts includes Japanese, Korean, Chinese Traditional, Chinese Simple, 
French, Italian, German, Spanish, and English. Usually, the default font is set to English. To change from the 
current language font, click the radio button of the desired language font. Fonts will change accordingly. If 
your computer does not support Asian language fonts, which are the top four languages fonts on the list, the 
text next to each radio button will display as little rectangles. To install the East Asian language fonts, refer to 
“Activating a Different Language” on page B-3.

Figure 3-98. Program Options Window with the Languages Tab Selected
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MST File Indexing – Trace Catalog
Use this dialog to set scheduling and other indexing parameters for selected files. See also Figure 5-15 for 
information about the use of this dialog.

• Trace Index Location

Select either Use Local Trace Index or Use Remote Trace Index to catalog files. Copy index to alternate 
location displays the Browse for Folder dialog from which you can select an existing folder or create a 
new one. 

• Indexing Schedule

Use the options in this section to:

• select the day or days Trace Indexing should occur. 

• set the time for Trace Indexing to begin.

• decide whether to include thumbnail pictures of the plot when indexing.

• Indexing Root Folder

Select the directory that contains the files of Traces to be indexed.

• Launch Trace Indexing on system startup – Runs the Trace Index program on startup and places the 
application icon on the Taskbar. 

• Load thumbnails – Loads thumbnails when displaying the list of indexed traces.

Window Buttons
Index Now – Begin indexing immediately, rather than wait for the scheduled indexing set time.

View Log – Opens a .txt file in Notepad to view all the indexing data – start date and time, elapsed time, and 
file types with the number of files indexed.

Figure 3-99. MST File Indexing Setup Window
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Archive Options – Trace Catalog
Use this dialog to select the files to archive. See Figure 5-16 for more information about the use of this dialog.

• Files to Archive 

Archive all selected files: Archives all highlighted files in the Trace Catalog window. 

Archive all .XXX files: Archives all files of the type selected. .XXX denotes the different file types 
supported by MST. 

Archive All Files in Index: Indexes all files in the Indexing root folder.

• Archive by Date 

From: Enter the start date for archiving.

Through: Enter the end date for archiving.

Preserve path names in archive: Runs the Trace Index program on startup and places the application icon 
on the MST taskbar. This option allows you to choose whether to include path names in the archive.

The Trace Indexer finds and lists all supported file types on the selected hard disk. This will give a list, for 
instance, of all VNA files on the disk regardless of where they are located, and allow sorting and selection 
based on certain defined measurement parameters. For purposes of backup, or to send a large file set to 
another location, the selected files can all be compressed (archived) into a ZIP file. A ZIP file can store original 
relative pathnames, so when it is unzipped the original folder structure is also rebuilt. Alternatively, the path 
names can be left out of the ZIP file so that when it is unzipped all the files end up in a single folder regardless 
of their original relative locations on the source disk. 

Figure 3-100.Archiving Options Setup Window
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Optional File Tasks
Right-click on a measurement window; then select File to access the functions in this section. Not all functions 
described are available to all measurement types.

Edit Main Title
Opens the Enter Title dialog to change the main title of the active measurement window panel. The dialog 
prefills the field with the title from the measurement window.

Edit Measurement Title
Opens the Enter Subtitle dialog to change the subtitle of the active measurement window panel. The dialog 
prefills the field with the subtitle from the measurement window.

Figure 3-101.Optional Measurement File Tasks

Figure 3-102.Title Entry Widow

Figure 3-103.Subtitle Entry Window
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Edit Operator Name
Opens the Enter Operator Name dialog to change the name of the operator.

Edit Tower Name
Opens the Enter Tower Name dialog window to change the name of the tower on which this file is stored.

Figure 3-104.Subtitle Entry Window

Figure 3-105.Subtitle Entry Window
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Chapter 4 — Using MST

4-1 Introduction
The core function of MST is to view and edit measurement files that are collected by supported Anritsu test 
instruments. The first step in using MST is opening a measurement file. Measurement files may come from 
many sources, but usually are captured as active measurements from a connected test instrument. Other ways 
to obtain them are: download them as stored measurement file from a connected test instrument or as a 
measurement file already stored on a local hard disk (or accessible network drive). The first step is to establish 
a connection. See “Connection and Configuration Using LAN” on page 2-2 and “Connection and Configuration 
with Other Methods” on page 2-21.

4-2 General File Management

Downloading and Uploading Measurement Files
After connecting, the software is ready to retrieve stored measurements or to capture the current 
measurement on a connected test instrument. The status bar along the window's bottom edge shows the status 
of the connection. The Connection button of the main toolbar also shows the status of the connection: green 
means connected; red means disconnected.

To capture the current measurement, click Capture Current Measurement button in the main toolbar (it is the 
arrow pointing downward). Alternatively, click Sync>Capture Current Measurement. This retrieves the 
measurement from the unit and displays it. The measurement appearance is similar to the measurement as 
displayed on the test instrument, so that users are not required to learn two entirely different display styles. In 
order to upload a measurement to a connected test instrument, press the Upload active window to instrument 
button (the icon is the arrow pointing upward) on the main toolbar. In the Sync menu, this function is labeled 
Upload Active Window. This automatically determines the file type and stores it in the appropriate location on 
the test instrument. 

The test instrument has three different memory locations where files can be stored. An instrument may 
potentially have stored traces on internal RAM, an inserted compact flash card, or on an inserted USB memory 
stick. Select the appropriate location before downloading or uploading. By default, the internal memory in the 
test instrument is used.

Some instruments provide a Compact Flash slot and a USB slot to add additional memory space for storing 
traces. When a connection is established to an instrument with MST, it displays a list of measurement files 
from internal memory, a compact flash, or a USB stick. The drop-down list in MST allows selection of which 
memory device to view. When files are downloaded or uploaded to/from an instrument, the currently selected 
memory space is used. 

After a connection is established, MST searches the test instrument for a file list. This file list displays along 
the left side of the application window under the Device tab. To open any file in this list, double-click with the 
mouse, or select the file and press Enter on the keyboard.

Figure 4-1. Instrument Memory Location Selection
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By default, whenever a file from the test instrument is opened, a local copy is retrieved and stored on the local 
hard disk. The location where this file is stored is found under the Local tab along the left side of the 
application window. This tab displays a folder and a file list. Browse to the desired location for file storage. 
Double-click a file in this Local list to open it in MST.

At the bottom, to the left of the application window, is a Measurement Preview/File Summary window. 
Whenever a file is selected, either in the Device or in a Local file list, a preview is generated and displayed. For 
most measurement modes, this is a picture indicating approximately how the file will appear when opened. For 
some file types, such as Antenna and Cable lists, no such graphical preview is available. In this case, the File 
Summary window shows an overview of the file contents. The Measurement Preview/File Summary attempts 
to track the program focus. When a file is selected either in the Device or in the Local file list, the preview 
shows that selected file. When an open measurement window is selected, the File Summary is for the 
measurement in the selected window.

Tabs just under the main menu bar have the following labels: Local, Device, Open, and Network. These tabs 
allow access to local files (on the local computer), available devices (internal memory, compact flash, or USB 
memory), open files (currently open measurements in the MST window), and network devices (test 
instruments that are connected to the available network).

The Network device list contains a list of all supported devices on the LAN. This list is not automatically 
generated and must be manually refreshed. Press the Query Network for Instruments button to populate or 
refresh this list. The Query Network for Instruments button is available only when the Network device list is 
open. A device that shows up in this list is not necessarily available. Each test instrument can maintain only 
one Ethernet connection, so if a device is busy when a connection is initiated, then MST fails to connect. 
Double-clicking a device in this list initiates a connection request.

A summary of each network device may be selected. The summary will appear in the File Summary area below 
the list. By default, this feature is turned OFF. Because many devices may already be in use, significant time 
can be consumed waiting for the Device Summary request to time-out. 

To turn on the Display Trace Preview/Summary feature, use the Program Options dialog that is found under the 
Tools main menu.

Standard File Commands
These standard Windows operating system commands for handling files are included in the File main menu: 
Open, Save, Save As (with a changed name), Print, and Close. These are standard operations and behave in a 
manner similar to other Windows applications. 

A few file operations are specific to MST and are described in the following sections.

Figure 4-2. File Resource Tabs

Figure 4-3. Measurement Preview
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Export
When exporting measurement data from MST, the measurement file is saved in a standard text-based file 
format that can be read by other common applications. This is a CSV (Comma Separated Value) format that is 
supported by Microsoft Excel and by other spreadsheet and data programs.

The CSV format changes slightly in different countries, depending upon customary use of commas and decimal 
points when expressing numbers. The Export dialog box has a File Type drop-down list with four options. 
Select the option that is appropriate for the file destination.

MST CSV Format Options:
• CSV (Comma delimited: #.##, #.##)(*.CSV), where a period indicates the decimal, and a comma 

separates the numbers.

• CSV (Semi-colon delimited: #,##; #,##)(*.CSV), where a comma indicates the decimal, and a semicolon 
separates the numbers.

• Text (Tab delimited: #.## [Tab] #.##)(*.txt), where a period indicates the decimal, and a tab separates the 
numbers.

• Text (Tab delimited: #,## [Tab] #,##)[*.txt), where a comma indicates the decimal, and a tab separates 
the numbers.

The File Type drop-down selection defaults to the file type that is appropriate for the Regional Setting of the 
computer. If many files are being sent to another area, then the Regional Setting could be changed in order to 
take advantage of the default test instrument setting. Some measurement types, such as VNA, have a number 
of additional options for exporting measurement data. These options are available by clicking the Edit Graph 
button in the Measurement Toolbar, which opens the Plot Setup dialog box.

Exporting S2P-Formatted VNA Files
The Anritsu VNA also has a specific export function for exporting S2P-formatted data files. This option is 
available under the File main menu only when a VNA file is open and active. Select this function for a 
standard Save File dialog box. Choose a filename and a destination and then press Ok to export the 
measurement in *.S2P format. The S2P format is an industry standard that is recognized by many simulation 
programs. S2P files are ASCII text files and can be viewed or edited by any standard text editor. The data in 
the files is not case sensitive.

Creating Measurement Reports
MST can create standard reports from any open measurement file in PDF or HTML format. Reports are also 
available for non-measurement files, such as antenna lists, cable lists, language tables, and so forth. Reports 
are formatted in PDF format (and viewed with the Acrobat Reader) HTML files that are intended to be viewed 
in an Internet browser. Several options determine what is included in a report, such as company name, 
company logo, and a signature line. These options are selected from the Program Options dialog box, which is 
available under the Tools main menu. Refer to Section 5-9 “Reports (.pdf and .html)” on page 5-4 for complete 
information on reports.

Saving JPEG Images from Open Measurements
A picture of a measurement can be captured as a JPEG image. This function is available under the File menu, 
but it is available only if the active window supports this function. Options are available for the saving of JPEG 
images, such as image quality and compression level, and whether or not to invert the colors in order to save on 
printer ink and toner. These options are available from the Program Options dialog box in the Tools main 
menu. A menu option is also available to create JPEG images from all measurements that are in a specified 
folder. This is an automatic process. When this option is selected, the test instrument prompts for a folder 
pathway for the folder that contains the measurement files to be processed. Then, using the JPEG settings that 
are found under Program Options, MST opens each file in the selected folder and creates a JPEG image. The 
output images are stored in an Image sub-folder under the specified source folder.
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Saving Folder as DAT
For HHST users migrating to MST, this command is used to convert the MST measurement file back to a DAT 
file. Former users of HHST, importing files from their instruments into MST, will have their measurement 
files automatically converted to the MST format. To export those same files back into the instruments use the 
DAT File Conversion Tool.

Printing All Open Measurements
Select the Print All option under the File menu to print all of the open measurements. A dialog box opens to 
allow specification of the layout and the number of measurements per page. The number of measurements to 
be printed on each page is not limited by the software, but needs to be set to an appropriate number for 
resolution and readability. Unless directed otherwise, MST automatically sets the size and format of each 
measurement for optimal printing. If many measurements are desired on a page, space can be conserved by 
turning off marker tables.

4-3 Editing Measurements
Each measurement type has a specific set of parameters that can be edited. Many of these parameters are 
common across most measurement types, and they are described briefly in the following section. Functions and 
Edits that are specific to each measurement type are described in later sections for those modes.

The Measurement toolbar, across the top of the Display Window, contains common functions available to most 
(but not all) measurement types. When a function is not applicable for the active window, the associated 
toolbar button is disabled.

4-4 Overlays
Clicking this button toggles any overlaid traces ON or OFF. If no traces have been overlaid, then no action 
occurs. Overlay files must be of the same file type and should have the same frequency range. The base 
measurement is used to determine the automatic frequency range. If a measurement that does not overlap in 
frequency is overlaid, then the overlapping measurement does not show in the plot without manually adjusting 
the plot range in the Plot Setup dialog box. Overlays may be added to a measurement in several ways.

• Drag from Local File List 

Click and drag a similar measurement file from the Local File list onto the measurement window where 
the overlay is desired. The mouse does not need to be in Drag Overlay mode for this operation.

• Drag from Windows Explorer

Click and drag a similar measurement file from Windows Explorer or from the Windows Desktop onto 
the desired measurement window. MST does not distinguish the file source, but responds as long as the 
file is a compatible (same measurement type) file.

• Drag a Similar Measurement

To drag an open measurement, the mouse must be in Drag Overlay mode. Otherwise, the mouse function 
will be to show plot coordinates, distance scale, or zooming. With the mouse in Drag Overlay mode, click 
anywhere on the source measurement and drag it over the target measurement. If MST determines that 
the files are not compatible, then no change occurs. 

• Edit Graph (The Plot Setup Dialog Box) Using Master Software Tools

Browse for overlay measurement files in the Plot Setup dialog box. Overlay files may also be selected by 
using the file browser in the Plot Setup dialog box. To access this screen, click the Edit Graph button in 
the Measurement Toolbar and select the Trace Math & Overlays tab page. From this tab, up to 6 files may 
be selected for overlay. 
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Individual overlay files are listed in the Overlay Traces section of the dialog box and may be turned on 
and off without disassociating the files. Clicking the Overlays button on the Measurement Toolbar 
toggles all of the check boxes in this window on and off.

Overlay Issues
Measurement overlays require that specific conditions be met, either to allow the overlay to occur or to allow 
the overlaid measurement to be displayed.

Dragging from the Device File List
In MST, when an overlay is added to a measurement, the overlay filename is stored in the original 
measurement file. Files with an overlay association can be saved and reloaded while maintaining the file 
overlay associations. If the files are moved together, then the overlays are still associated and are shown when 
the base file is reloaded. In other words, a file cannot be overlaid directly from the device: it must be copied to 
the local computer disk space first so that a local filename exists to be associated with the base file.

Dragging Open Measurement Files
Establishing an overlay assciation among files sometimes cannot be achieved by dragging open measurement 
files inside the Display Window. Depending upon the options that have been selected, opening a device file may 
or may not automatically save the file in the local disk space. (By default, all files that are opened from a 
connected test instrument are saved locally.) If this option is turned off, then a remote file can be opened 
directly without creating a local copy of the measurement file. In this situation, this measurement cannot be 
overlaid onto another measurement because no local filename is associated with the measurement.

Frequency Range of Base Measurement File
MST uses the base measurement file to set the frequency (x-axis) range when displaying data. If, after an 
overlay request, the frequency range of the overlaid measurement does not overlap the frequency range of the 
base measurement, then the overlaid measurement does not show on the plot screen. The x-axis range can be 
reset in the Plot Setup dialog box.

Overlay File Name 
When a measurement is overlaid, its filename appears across the top-left corner of the graph in the 
measurement window. If no filename appears, then the file did not overlay correctly, either because the file 
does not exist in the local disk space, or because it is an incompatible file type.

4-5 Edit Graph (Plot Setup Dialog Box)
This Measurement Toolbar button opens a Plot Setup dialog box. This dialog box is different for different 
measurement types. offering more choices for some than for others. Each Measurement window also has a 
context menu (mouse menu) that is accessible by right-clicking the graph. Many of the settings on the context 
menu are duplicated in the Plot Setup dialog box. If a single option is being changed, then the context menu is 
convenient to use. When changing more options or changing advanced options that are not available on the 
context menu, the Plot Setup dialog box is more efficient.

Note A measurement must be saved locally before it can be overlaid.
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4-6 Common Options
These options are common to almost all supported measurement types and are described here in general 
terms. For specific options not included here, refer to the section of this User Guide specific to the 
measurement type of interest.

Autoscale
Autoscale expands the vertical scale to spread the measurement over 70% to 80% of the measurement window. 
When this is done, the number of horizontal graticule lines is reduced by an amount that depends upon the 
vertical spread of the measurement that is being auto-scaled.

Undo Zoom
Regardless of how many times the user has zoomed in on a measurement, clicking the Undo Zoom button sets 
the active measurement window to display the entire sweep. Zoom steps are not undone one at a time, but all 
at once.

Marker Table
Many measurement types support data markers. When monitoring a supported measurement type, the 
visibility of the marker table can be toggled on and off. The marker table must be visible in order to turn 
specific markers on and off, but the position of markers can be adjusted without using the marker table.

Marker Shape
Marker shape can be either a line or an inverted triangle. This sets the shape of the data markers that are 
displayed on the graph.

Plot Range
For measurements that consist of x/y data sets, the x-axis and y-axis ranges can be set in the Plot Setup dialog 
box. Some measurements have fixed ranges. Generally, if the range can be changed on the test instrument, 
then the range can also be changed in MST. If the range is fixed in the test instrument, then it is fixed in MST.

For measurement types with variable plot limits, the display can also be varied using the mouse in Zoom mode. 
The plot limits that are set in the Plot Setup dialog box are not the visible zoom limits, but are the limits to 
which a plot is reset when using the undo zoom function (via the Undo Zoom button in the tool bar). 

When a measurement is saved in MST, the zoom range is not saved. Any changes made to the plot limits in the 
Plot Setup dialog box are saved and become the default limits if the measurement is recalled, either in MST or 
on a test instrument.

Plot Mode
In several cases, a data set that is stored on a test instrument may contain valid data for more than one view 
mode. For example, GSM measurements are taken in one of four modes, and the saved measurement file 
contains valid data for all four views. In this example, the Plot Setup dialog box allows the selection of 
alternate views from the data. In other cases, data can be translated into alternate views. VNA data sets that 
are stored as x/y data can be translated into Smith chart data. Similarly, some VNA measurements can be 
converted to Group Delay measurements even though this is not the view that was originally saved. These 
alternate views are accessed through the Plot Setup dialog box.
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Measurement Overlays
Measurement types that support overlays have a tab in the Plot Setup dialog box for choosing overlay files and 
for turning on and off specific overlay associations. To add an overlay, click the Add button and browse to the 
desired file. To remove an overlay, select it in the list and press the Remove button. An overlay can be 
temporarily hidden by unchecking it in the list.

Overlay files can also be moved up and down in the overlay list. This is useful for measurement types (SPA and 
VNA) that allow trace math because the trace math typically is performed between the base trace and the first 
overlay.

Trace Math
This option is currently available only for SPA and VNA traces. When Trace Math is active, the base trace is 
added to the first overlay, the base trace is subtracted from the first overlay, or the first overlay is subtracted 
from the base trace.

Trace Smoothing
This option is available only for SPA and VNA traces, and is normally useful only with VNA data. This option 
allows for the trace to be smoothed by a simple moving average. The smoothing shape is either rectangular or 
weighted. A weighted smoothing gives more weight in the averaging of points that are closer (along the x-axis) 
to the original point.

The smoothing window is set with a percent value. When set to 2% for example, the smoothing window is 2% of 
the total trace width. If the trace would have 500 points (in this example), then the smoothing window would 
have 10 points (2% of 500), which means that each point would be averaged with 5 points on each side of it. 

The original trace and the smoothed trace can be on screen together, which gives a clear overview of the effect 
of the smoothing. Smoothing affects trace math. Both can be on simultaneously, and the trace that is a result of 
the trace math is smoothed.

Note

Saving a file in MST does not save every change made to a measurement. Typically, these files exist 
as an image of a stored measurement on a test instrument. Only parameter changes that could have 
been changed on the test instrument are saved in the measurement file. For example, a change of 
text size is not saved in the measurement file, but edits to limit lines are saved.
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4-7 Working with Limit Lines and Markers

Working with Limit Lines in the Active Measurement Window
Limit lines are defined by a series of nodes. All limit lines must have at least two nodes, a beginning node and 
an ending node. Segmented limit lines have more than two nodes and can take on more complex shapes. To 
edit a limit line, select a node and right-click for the Node context menu. This provides a number of options to 
quickly set or reset limit lines, and to add, move, and remove nodes. Nodes are sometimes difficult to select. 
When the mouse pointer is directly over a limit line node, the node changes shape.

Many measurement types support limit lines. To turn on limit lines, use the Plot Setup dialog box (Edit Graph 
button on the measurement toolbar) or use the Limit Line menu options on the measurement context menu.

Limit lines can be edited in several ways.

Method 1 (Enter the Value of the Limit Line)
1. Turn on the limit line.

2. Right-click the Display Window.

3. Highlight Data Display Mode... or Data Display Options... and click.

4. Enter the value of the upper limit line, lower limit line, or both. This deletes all but the beginning 
and ending nodes.

5. Click OK when done.

Method 2 (Enter the Value of the Nodes)
1. Turn on the limit line.

2. Place the mouse cursor on the start node or end node and click once on the node.

3. Right-click and select Edit Node.

4. Enter the frequency and the amplitude of the start node.

5. Click OK.

6. Move the cursor to the end node.

7. Right-click and select Edit Node.

8. Enter the frequency and the amplitude of the end node.

9. Click OK.

Method 3 (Drag the Start and End Points)
1. Turn on the limit line.

2. Place the cursor on the start node and drag it to the desired position.

3. Place the cursor on the end node and drag it to the desired position.

Method 4 (Editing Segmented Limit Lines) 
Segmented limit lines can be created in MST.

1. Right-click the Display Window and select View Limit Lines.

2. Right-click the start and select Add Node in order to add a node or select Delete Node in order to 
delete a node. Deleting the end node deletes the limit line.

3. Use the left mouse button and drag the new node to its new location, or right-click and select Edit 
Node and enter the desired amplitude and frequency values of the node.



Using MST 4-7 Working with Limit Lines and Markers

Master Software Tools UG PN: 10580-00439  Rev. B 4-9

Working with Markers in the Active Measurement Window
Markers are supported for many graph types. If a test instrument measurement mode supports markers, then 
MST also supports markers for those measurements. A marker table can be turned on at the bottom of the 
measurement window through the measurement context menu or by using the Plot Setup dialog box.

1. Display the Marker Table.

• Using the Toolbar Icon:

Click the Markers icon on the Graph Edit Toolbar.

• Using the Context Menu:

a. Place the mouse cursor over the active measurement display.

b. Press the right mouse button. Scroll down to Data Markers to open the sub-menu for 
enabling and setting up the markers.

c. Click Display Marker Table.

Figure 4-4. Context Menu: Display Data Marker Table
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2. Click the box in the Ref column of the marker table to place markers on the measurement window. A red 
marker and red box denotes the active the marker, which can be moved or set to another position of the 
trace or between multiple traces.

3. There are multiple ways of moving and setting markers. Use the following procedures to:

• Move a Marker

a. To easily grab the marker, place the cursor on the marker label and hold down the left 
mouse button.

b. Drag the marker to the new position. Release the mouse button.

• Move a Marker to Peak

a. Press the Markers pull-down arrow button.

b. Highlight Marker to Peak and click the desired marker.

• Move a Marker to Valley

a. Press the Markers pull-down arrow button.

b. Highlight Marker To Valleys and click the desired marker.

• Activate/Deactivate a Delta Marker

a. Click the Markers tab to display Markers table below trace.

b. Check the desired Delta marker of the corresponding active marker.

c. Move the delta marker by placing the cursor on the delta marker label and holding down the 
left mouse button.

d. Drag the delta marker to the new position. Release the mouse button.

Figure 4-5. Trace Display with Data Marker Table Below
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• Place a Marker on a Peak between Selected Markers

a. Press the Markers pull-down arrow button.

b. Highlight Peak Between Marker.
c. Select a marker, M1-M6.

d. Click the desired marker pair where the peak is to be found. 

• Place Marker in a Valley between Selected Markers

a. Press the Markers pull-down arrow button.

b. Highlight Valley Between Markers.

c. Select a marker, M1-M6.

d. Click the desired marker pair where the valley is to be found.

4-8 Annotating Graphs
SPA (Spectrum Analyzer) and IA (Interference Analyzer) measurements support Graph annotations. A graph 
annotation is a note that is added to a graph in a rectangular area, which is connected to a specific point on the 
measurement curve by a vertical line. Text is added to an annotation by double-clicking the annotation box 
with the mouse. The annotation can automatically include the frequency and power level at the referenced 
location. Notes can be edited, hidden and deleted. All hidden notes can be displayed by clicking the Show All 
Notes command line.

To add an annotation:

1. Select Annotations on the measurement context menu (the mouse menu).

Figure 4-6. Annotation Controls Menu
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2. Select Add New Note from the Annotations sub-menu. A yellow Note is placed in the top left corner of the 
graph.

3. Annotations can be added, removed, and hidden. Hidden annotations do not show on the display, but 
they do not lose their place or their text. To position an annotation box, click and hold with the left mouse 
button while dragging it to the desired location.

To edit an annotation:

1. Place the cursor over the Note to be edited. Click the right mouse button.

2. Pull down the Annotations menu.

3. Select Edit Selected Note on the context menu (the mouse menu). The Note Entry window pops up.

4. Enter new text in the dialog box.

Figure 4-7. Active Measurement Window Panel with Annotations

Figure 4-8. Annotation Entry Window
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5. To remove the frequency and power values from the Note, uncheck the Show Frequency & Power check 
box.

6. Click OK. The measurement window displays the new text.

To delete an annotation:

1. Place the cursor over the Note to be deleted and click the right mouse button.

2. Pull down the Annotations menu.

3. Select Delete Selected Note on the context menu (the mouse menu). 

4. The Note is deleted from window. Deleted Notes cannot be recovered.

4-9 Remote Access Tool
Remote Access Tool is a fully functional software emulator that remotely controls the test instrument 
connected to the computer. All supported instruments are displayed with their specific front panel. Hard 
buttons, soft buttons and graphic display emulate the test instrument.

Remote Access Tool only works with a LAN or direct Ethernet connection.

1. Open the Tools menu, and click the Remote Access Tool command line. A generic test instrument front 
panel displays in the Active Measurement Window.

Note
Anritsu recommends using the most recent remote access software Wireless Remote Access Tool. 
Go to the Anritsu Website to download this software:
https://www.anritsu.com/en-us/test-measurement/products/wrt

Figure 4-9. Tools Menu
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2. Click the dark green ON button in the top right corner. The first sentence in the test instrument screen 
changes to “The instrument screen should display in a moment” indicating the software emulator is 
being loaded.

3. The test instrument front panel for the test instrument connected to the computer displays. If the test 
instrument front panel display does not appear, verify that the IP address is selected in the main 

Figure 4-10. Initial Generic Test Instrument Panel

Figure 4-11. Text Close Up
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toolbar. If the connection cannot be established, verify that the test instrument firmware has been 
updated to support the Remote Access Tool. 

4. Refer to the specific User Guide for the test instrument for more information on setting up and taking 
measurements.

If the computer mouse has a scroll wheel, place the cursor over the rotary knob and use the scroll wheel to 
rotate the knob. This feature is useful in changing the graph scale or scrolling through a menu. Clicking the 
left mouse button on the rotary knob acts as an Enter button.

All hard keys on the test instrument emulator operate like the hard keys on the test instrument. In the case of 
the soft keys, use the mouse to push the soft-key labels and function hard keys directly. The cursor will change 
from cross-hairs to a pointer when active. 

Remote Access Tools provides the ability to use the test instrument emulator with MST in the connected or 
disconnected mode. See Fig. 4-10.

The Ethernet cable is connected in either mode. With MST connected to the test instrument, that single user is 
able to manipulate that test instrument via Remote Access Tools. Disconnect the software by clicking   
Connection>Disconnect command line in the menu. All of the emulator test instrument’s buttons are disabled. 

Figure 4-12. BTS Master MT8222A Emulator Example

Figure 4-13. Ethernet Currently Software Connected
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Multiple users are able to monitor the testing done and the measurements taken by the test instrument. When 
multiple users are monitoring the test instrument, consider lengthening the refresh rate for updating 
information from the test instrument. If too many users are monitoring the test instrument with a short 
refresh rate, the test instrument’s main function will be updating the users rather than taking measurements. 
Select a longer rate that would accommodate the multiple users monitoring the test instrument.

Also, the more users monitoring the test instrument the more slowly the data processing takes place. Multiple 
users consume the test instrument’s resources thereby slowing down the test and measurement processes. 

Figure 4-14. Refresh Rate Default Set to 2 Seconds
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4-10 3D Spectrogram
The 3D Spectrogram function allows you to view a folder of measurement traces in true 3 dimensions – 
frequency, time, and amplitude. Use markers to select or point out specific frequencies and amplitudes. With 
Signal ID, you can view specific types of signals and their SNR. To access 3D Spectrogram first open a Folder 
Spectrogram window.

To open the Folder Spectrogram window:

1. Click File>New>Folder Spectrogram.

2. The Browse for Folder dialog displays. Navigate to the folder containing the files that you want MST to 
display a spectrogram. These files may be copied from any source, including an Anritsu instrument.

3. Click OK. The SPA or IA files dialog displays. Select the button appropriate to the files you wan to see.

4. The Folder Spectrogram measurement window displays.

If there are unknown or extraneous files in the directory, you might see this message: 

Follow the next procedure to generate a full spectrogram.

Figure 4-15. Browse for Files for New Spectrogram 

Figure 4-16. SPA or IA Dialog 

Figure 4-17. Message warning of extraneous files present in selected folder 
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To access 3D Spectrogram with a Folder Spectrogram window open:

1. Right-click the Folder Spectrogram window to list the context menu.

2. Click the command line 3D Spectrogram View. The 3D Spectrogram window opens.

Active Marker Data: Displays the data for the marker selected in the Active column of the Marker table. 
Data includes frequency, amplitude, date, time, and, if applicable, the GPS stamp. Right-click on this 
view to cycle through the three view: spectrogram, single plane, and top view.

Figure 4-18. Folder Spectrogram Window with the Context Menu Listed

Figure 4-19. 3D Spectrogram Window: Signal ID view
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Marker Table 
Click the Markers radio button to show the marker table of the 3D spectrogram view.

The columns are:

Enable: Click to place an X in the box to make a marker available for use. The marker will appear in the 
field of the spectrogram, and may be manipulated by dragging around the graph. Click on the X to turn 
off the marker.

Ref: Use this function to choose a marker as the reference value against which the deltas are calculated. 
Click the box to the right of Ref. to enable the reference function. Click the Ref. radio button for the 
enabled marker you want to use as the reference. All delta information is in relation to the selected 
reference marker, Peak Min, or Peak Max value.

Active: Selects a marker to work with. Information for that marker is highlighted in yellow in the top left 
corner of the window and titled Active MKx. If the GPS function was on during the measurement, GPS 
data also display.

Freq (MHz): Displays the frequency of the enabled markers.

Level (dBm): Displays the power level of the enabled markers and peak level planes.

Delta (MHz): Displays the frequency difference between the frequency of the selected reference marker to 
the other enabled markers frequencies.

Delta (dB): Displays the difference in power between the reference marker and reference peak level to the 
other enabled markers and peak level reference.

Marker Color: This rightmost column displays the color-coded marker associated with each marker.

Figure 4-20. 3D Spectrogram Window: Marker Table view
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Signal ID Table
Click the Signal ID radio button to view the Signal ID table. It shows various attributes of the signals detected 
in the spectrogram.

The columns and buttons are:

Display: Click to place an X in the box to make a marker available for use.

Signal Name: Lists the identified signals found on the single measurement trace.

Center Freq: Displays the center frequency of the identified signal.

Bandwidth: Displays frequency bandwidth of the identified signal.

CH Power: Displays the channel power level of the identified signal.

Carrier #: Displays the number of carriers for the identified signal

SNR: Displays the difference in power between the reference marker or reference peak level to the other 
enabled markers and peak level reference.

Details Button: Opens the Signal ID Summary table.

Signal ID Summary
Click the Details button in the Signal ID table view of the spectrogram. The Signal ID Summary window 
allows you to sort and filter measurements in the 3D Spectrogram. 

The Summary tree, displays all types of Signal IDs. Figure 4-17 shows there are 464 FM signals and 39 WLAN 
signals in this measurement folder. You can analyze these measurements by filtering them using Channel 
Power Filter, SNR Filter, and Frequency Filter. You can also sort these measurements in ascending or 
descending order by pressing the desired column title bar, e.g. Center Frequency.

Figure 4-21. Signal Table

Figure 4-22. Signal ID Summary Window
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3D Spectrogram
The three-dimensional view of the list of measurement displayed in amplitude, frequency, and time.

3D Spectrogram Display Controls
Rotate: Rotate has three control bars. The top control bar rotates the 3D Spectrogram forward and back. 
The middle control bar rotates the 3D Spectrogram on the horizontal plane. In addition, the bottom 
control bar rotates the 3D Spectrogram clock-wise and counter-clock-wise.

Level Scale: Use this control bar to increase or decrease the power level magnitude scale.

Zoom: Zoom in or zoom out of the 3D view.

Threshold xx.yy dBm: Raise or lower the Amplitude Threshold Plane.

Top View
Shows the 3D Spectrogram from the top. You can see the movement of either Frequency Domain Plane or Time 
Domain Plane. This view also displays the markers. See Figure 4-19, “3D Spectrogram Window: Signal ID 
view” on page 4-18.

Single Plane Frequency Domain or Time Domain View
Displays a single measurement in Frequency Domain or Time Domain. The Frequency Domain displays the 
amplitude of a single frequency. In the Time Domain, the center frequency is highlighted in yellow and the 
bandwidth in red. See Figure 4-19, “3D Spectrogram Window: Signal ID view” on page 4-18.

Time Domain View Controls
Time Domain: Places the single plane view to Time Domain.

Play: Starts the automatic sweep of the frequencies.

Stop: Stops the automatic sweep of the Time Domain panel.

Manual Control: Use this control to manually move the Time Domain panel left to right, 
right to left.

Frequency Domain View Controls
Frequency Domain: Places the single plane view to Frequency Domain.

Play: Starts the automatic sweep of the signal amplitude.

Stop: Stops the automatic sweep of the Frequency Domain panel.

Manual Control: Use this control to manually move the Frequency Domain panel front to 
back, back to front.
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Miscellaneous Controls
Reset: Resets the 3D Spectrogram to the default view.

Help: Displays the default Keyboard/Mouse controls window.

Options: Displays the Control Configuration window. See “Dialog Options” on page 4-23. 

Exit (ESC): Exits 3D Spectrogram and returns to the Folder Spectrogram view.

Figure 4-23. Keyboard & Mouse Default Configuration Window
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Dialog Options
Select the desired portion of the 3D Spectrogram window to configure – Graph, View 1, View 2, View 3, 
Markers, and Signal ID. The large Middle Options Panel title and setup parameters change accordingly.

Middle Options Panel
Defines the keyboard keys for additional movement control through the 3D Spectrogram. The setup 
parameters deal with configuring text, background, dialog, and graph lines annotations. Set these features as 
desired.

Figure 4-24. Spectrogram Setup Window
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Edit Controls: 
Press this button to configure keyboard and mouse keys used in the 3D Spectrogram window.

Keyboard: Defines the keyboard keys for additional movement control through the 3D Spectrogram window. To 
make changes in controls, follow the instructions in the Information panel. Press OK to keep changes, press 
Cancel to exit and discard changes.

Mouse: Defines the mouse keys for additional movement control through the 3D Spectrogram window. To 
make changes in controls, follow the instructions in the Information panel. Press OK to keep changes, press 
Cancel to exit and not make any changes.

Figure 4-25.  Keyboard & Mouse Configuration Window
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4-11 Script Master Editor
The Script Master Editor provides a means of creating measurement setups, sequences, and processes within a 
Script File that can be uploaded into an instrument. These Script Files can be setup and measurement test 
sequence only or they can be interactive with the instrument user. An interactive Script File could prompt the 
user for real-time measurement parameters or for test sequence changes.

Currently, Script Master generates Script Files for the measurement mode types – GSM/GPRS/EDGE, 
WCDMA/HSDPA, and Channel Scanner. The Script Master function is found in the File menu.

GSM/WCDMA Script Master

Figure 4-26. Script Master Command Line Listed Under File Menu

Figure 4-27. GSM/WCDMA Script Master Editor

Toolbar
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Toolbar

Test List Panel
Contains the list of individual tests that make up the testing procedure.

Script Setup Panels
• Setup Parameters

Used to change parameters on the instrument and to prompt the user of these changes if necessary.

Mode: Press the down arrow of the Select Mode: list box to select either GSM (GSM/GPRS/EDGE) or 
WCDMA (WCDMA/HSDPA) measurement mode testing.

Parameter Values: These are the test parameters specific to the measurement mode selected in the Select 
Mode list box. 

ParamName: The name of the measurement parameter.

Value: Enter a value to change that parameter value in the instrument. Leaving the value as No Change, 
defaults to the value in the instrument.

Prompt: A checked box prompts the user of the instrument of the changes taking place with the edited 
parameter.

Parameter Description: A brief description of the selected parameter displays.

• Setup Measurements
Used to change measurement settings on the instrument. and to prompt the user of these changes if 
necessary.

Selected Measurements: text.

Param Name: Press the down arrow to list the measurements of the selected mode. Highlight and click 
the desired parameter for editing.

Value1 - Value4: Entry boxes for value editing of the selected measurement.

Possible Value: Displays the possible values for the selected measurement. 

Description: Displays the limits and units for the selected measurement. Some measurements do not 
have values such as the Spectral measurement.

New Clears the Properties and Image Designer Window to create a new test.

Open Opens a list window to select for editing previously created Script files.

Save Saves the current file to the computer.

Save As Saves the file with a new filename and .pfs extension.

Print Prints the file to the default printer.

Add Test Adds a new test to the Test Panel. The new test is a blank form ready for editing.

Delete Test Deletes the highlighted test from the Test Panel.
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• Image Select Toolbar

Text: Click to open the text Input window. Enter a label name. Press OK and the labeled text box will be 
placed on the Image Designer window.

Picture: Click to open the Picture dialogue window to select a picture from the computer. Highlight the 
desired picture and press the Open button; the picture displays in the Image Designer window. 

Delete: Deletes the active text or picture box in the Image Designer window.

Image Properties Editor
The Properties Editor window displays different types of editing fields, depending on the needs of 
particular property. These edit fields include edit boxes and drop-down lists. 

Use this window to define the active text or active picture box in the Image Designer window. When a 
text or picture box is placed in the Image Designer, properties for that box are listed in the editor. 
Highlight the desired property to edit.

Image Designer Pane
Create visual notes or instructions to be loaded into the test instrument for the field tech or FAE taking 
measurements. You can resize and position text and picture boxes using the dragging feature.

Channel Scanner Script Master 

Toolbar
The icons of the toolbar for the Channel Scanner Editor: 

Figure 4-28. Channel Scanner Script Editor

Open Opens a list window to select for editing 
previously created Script files.

Save Saves the current file to the computer.
Save As Saves the file with a new filename with a .smcs 

extension.
Open Wizard Dialog Opens the Populate Wizard for creating the 

Scan List. Select either Scan Channels or Scan 
Frequency as the desired method of creating the 
Scan List. Refer to “Dialog Options” 
on page 4-23.
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Script Setup Panel
Name: Displays the name of an opened Script file.

Record: Sets the parameter for the Record button in the instrument to the On position.

Scan Setup Panel
Click the desired radio button to select setting up the test duration using either Number of Scans or 
Time Duration. If the Number of Scans is selected for the test duration, then the test will end after the 
Scan List has been repeated the total number of List scans and Set of 20 scans. 

If Time Duration is used, then testing occurs for that time. If the test time of the Scan List is shorter 
than the Time Duration set, the Scan List will continue and repeat testing until the end of the set Time 
Duration. If the test time of the Scan List is longer than the Time Duration set, the tests beyond the 
Time Duration period will not be tested.

Number Scans: Set the number of scans with List and Set of 20.

List: Enter the number of repetitions the channels in the Scan List are to be tested. (Maximum 
1000 repetitions.)

Set of 20: Enter the number of repetitions a set of 20 channels are to be tested. (Maximum 5 
repetitions.)

Time Duration:  Set the duration that the in which scans must complete.

Day: Enter the number of days the Scan List is to be tested.

Hour: Enter the number of hours the Scan List is to be tested.

Min: Enter the number of minutes the Scan List is to be tested.

Scan List Editor
Create a Scan List using the Open Wizard Dialog or manually enter individual Signal Standards and 
corresponding ChannelNumber, Frequency, and ChannelWidth values.

SignalStandard: Press the pull-down arrow to select a signal standard. Click Channel Number and its 
value along with Frequency, and ChannelWidth will be entered automatically.

ChannelNumber: Double-click the entry box and press the down arrow key to open the entry window. 
Enter a Channel Number within the range of channels listed. Frequency and ChannelWidth will be 
entered automatically.

Frequency: Automatically entered during SignalStandard set up or ChannelNumber set up.

ChannelWidth: Automatically entered during SignalStandard set up or ChannelNumber set up.

Measurement Log File
After the Channel Scanner measurement is complete, a log file or multiple log files are created. A log 
file is created for the number of List repetitions set. If List is set to 1, then there is only one log file 
created. If List is set to the maximum number of 1000, then 1000 log files are created. 

Delete Deletes the highlighted channel from the Scan 
List.

Clear Channel Scanner Scan List Clears the Scan List for creating a new Channel 
Scanner list.

Open Signal Standard File Opens the Signal Standard file for editing.
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The log file name format is SCRIPT_MASTER_LOG followed by a string of numbers that represent year, 
month, date, hour, minute, and seconds that is expressed as YYYYMMDDHHMMSS - year (YYYY), 
month (MM), date (DD), hour (HH), minute (MM), and second (SS).

Double-click on a log file entry in the list to display in the Log Viewer.

Table Definitions
The commands in the toolbar of the Log Viewer are described in this table:

Figure 4-29. Device List of Log Files

Figure 4-30. Measurement Log Viewer

Move First Returns to the first measurement in the Scan List and highlighted in dark blue.

Move Previous Moves the counter to the previous measurement. 
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Row Color
Dark Blue: Highlighted row that corresponds to the measurement number in the Scan List counter.

Yellow: A set of twenty measurements. This list may be less than twenty if it is at the end of the 
measurement list.

Light Blue: A set of twenty measurements. This list may be less than twenty if it is at the end of the 
measurement list.

Measurement Graph
Displays the level of power for each Set measurement in a graph. For example, if the Set of 20: 
parameter is set to 4, four graph bars are displayed.

Powers (dBm)
Displays the numeric value for each Set measurement in a column. For example, if the Set of 20: 
parameter is set to 4, four values bars are displayed in a column.

Select 
Measurement

Displays the current measurement number. To jump directly to a measurement, enter the 
number of the desired measurement into the entry window and press Enter on the 
keyboard.

Move Next Moves to the next measurement. 

Move Last Moves the counter and the cursor to the last measurement. 

Open Channel 
Scanner File

Open a file on the computer into the Log Viewer. 

Export to CSV Opens the Export file dialog. 



Using MST 4-12 VNA Master Measurement Window

Master Software Tools UG PN: 10580-00439  Rev. B 4-31

4-12 VNA Master Measurement Window
The VNA Master Measurement Window in MST replicates the display window on the VNA Master 
instruments. Both real-time measurements and previously captured and saved measurements will be viewed 
as though they were on the instrument. The measurement window also allows you to set the number of graph 
display panels and set the number of traces viewed.

Toolbar

Figure 4-31. VNA Master Trace Window

Open Opens a list window to select for viewing previously saved VNA measurement files.

Save Saves the current file to the computer.

    Number of 
Graph Display 
Panels Select

Press one of the four boxes to set the number of graphic display panels.
Yellow: Utilizes the full display area for one Display Panel.

Yellow/Purple: Splits the display area vertically for two Display Panels.
Yellow/Purple/Green: Divides the display area into three panels: graph display panel 1 at the 
top left quadrant, graph display panel 2 in the top right quadrant, and graph display panel 3 
utilizing the bottom two quadrants.
Yellow/Purple/Green/White: Divides the display area into four quadrants: graph display 
panel 1 at the top left quadrant, graph display panel 2 in the top right quadrant, graph 
display panel 3 in the bottom left quadrant, and graph display panel 4 in the bottom right 
quadrant.

   Set the Number 
of Traces for 

Display

Sets the number of traces to be displayed in the selected number of graph display panels. 
Traces are color-coded to match its data in the Trace Information section. 

Note
The file downloaded from the instrument can have one to four traces displayed. This setting in MST 
can only limit the number of traces displayed on the computer. For example, if the instrument only 
had two traces, then MST can display one or two traces but not more.
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General Instrument Setting Summary
Displays the setting information that is common to all traces: Number of Points, IF Bandwidth, Sweep 
Averaging, Power, Reference Plane Extension for Port 1 and Port 2, and Bias Tee status.

Trace Setting Summary Panel
Displays the information of each of the number of traces set for display. Information included are S-parameter, 
graph type, smoothing %, and scale settings – resolution/division, and reference value.

Active Trace Indicator: Highlights the active trace with a light blue rectangle.

Graph Display Window
Displays one through four graph display panels depending on the selection made on the Toolbar for the 
Number of Graph Display Panels.

Example Views – Multiple Combinations of Number of Graphs and Number of Traces.

Figure 4-32. Four Graphs with Four Traces
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The display file supports up to four live traces. MST can open and display all four traces as shown in Fig 4-44 
above. The image shows four traces, each in its own graph display panel. Click the Yellow button on the toolbar 
to change MST to show all four traces on a single graph as shown below, Figure 4-33.

Figure 4-33. Single Graph with Four Traces
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Figure 4-34. Two Graphs with Four Traces

Figure 4-35. Three Graphs with Four Traces
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Also, in MST you can change the number of traces from the maximum available down to one. In the case where 
four traces are available, as shown above, you can change the number of traces to three, two, or one as shown 
below.

Note

MST follows the same trace numbering procedure found in the instrument. When displaying one 
trace, TR1 is shown. When displaying two traces, TR1 and TR2 are shown. When displaying three 
traces, TR1, TR2, and TR3 are shown. When displaying four traces, TR1, TR2, TR3, andTR4 are 
shown. You cannot display TR2, TR3, or TR4 as a single trace in MST.

Figure 4-36. Three Traces Displayed, Four Graphs Selected
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Figure 4-37. Two Traces Displayed, Four Graphs Selected

Figure 4-38. One Trace Displayed, Four Graphs Selected
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MST also allows you to choose the active trace by clicking the trace number - TR1, TR2, TR3, or TR4 in the 
Trace Setting Summary Panel. The selected active trace is highlighted with a light blue rectangle. The reason 
to choose an active trace is for cases when you have more than one trace overlaid in the same display panel. 
MST can only display the y-axis scale information for one trace, the Active Trace. In Fig. 4-51 below, TR1 is 
highlighted in the left hand column, indicating it as the active trace. Therefore, the y-axis scale shown is 
associated with Trace 1 (yellow). In Fig. 4-52, TR2 is the active trace and the y-axis scale is changed to match 
the TR2 settings (purple).

Figure 4-39. TR1 Selected as the Active Trace
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Figure 4-40. TR2 Selected as the Active Trace

Note

1. MST supports markers and limits for the VNA Master. That is, any files you download today will 
be able to display markers and limits including VNA Master files, for example, DTF-Return Loss, 
Cable Loss, Return Loss, 2-Port Gain files. 

2. The Trace Catalog function in MST supports the VNA Master files, for example, DTF-Return 
Loss, Cable Loss, Return Loss, 2-Port Gain files.

3. MST downloads the trace data from the instrument after post processing.
4. MST creates a folder named TEMP in the INTERNAL MEMORY of the instrument to store files 

while downloading them to the computer. MST will view and download any folder or file in TEMP.
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Chapter 5 — Support File Management

5-1 Introduction
Support files for measurements include:

Some of these files originate on the test instrument and can be edited in MST and uploaded back to the test 
instrument in order to change test instrument behavior. Other files are created as MST files and cannot be 
uploaded to a test instrument. Each file type has an associated view or editor. These files have characteristics 
in common, both with each other and with standard measurement files.

In general, any file that can be opened in MST can be saved, printed, exported, and turned into a report. In the 
unusual case where one or more of these options are not available, the option is either not shown or is shown 
disabled (menu option grayed out). If a file can be uploaded, the Upload button is enabled when the file is 
active and an active device connection exists.

The following descriptions describe how to edit a file from a connected test instrument, because this is the most 
common situation. These files can be saved locally and then recalled by using the File >Open... menu function, 
or by pressing the Open button on the main toolbar. The File>Open... menu function or the Open command in 
the main tool bar opens the Open Measurement File dialog box.

5-2 Antenna Editor (antenna.txt)
The Antenna Editor is used to edit antenna lists. All measurement modes on an Anritsu test instrument share 
one antenna file. This antenna file has multiple antenna definitions, each of which has a triplet of 
frequency-antenna factor-antenna gain values that define the antenna response characteristics.

• Antenna lists • Signal standard files

• Cable lists • Pass/Fail test definitions

• Language tables • Instrument setup files

• Calibration files • JPEG images

• Reports • Exported files

• Folder Spectrogram files • Measurement map files

Figure 5-1. Antenna Editor Window
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To edit an antenna file, download the file from a test instrument by clicking Sync>Download Antenna List. 

MST retrieves the antenna list and opens it. Unless the Auto-save feature under Program Options has been 
turned off, the file will automatically be saved to a local disk using the path shown in the File Summary 
preview (under the Local tab on the left side of the application window).

The antenna file on the test instrument is named antenna.txt, and this is the default name that used by MST. 
The antenna list can be edited and saved on a local computer under any desired filename, but when uploaded 
to the instrument, it must be named antenna.txt, or the test instrument will not recognize it.

To add a new antenna to the list:

1. Drag the file antenna.txt from the File List Window to the Active Measurement/Edit Window. The 
Antenna Editor window immediately opens the list of antennas.

2. In the column listed Antennas, scroll down to the bottom of list.

3. Highlight the empty box.

4. Enter the new antenna name in that box. 

5. Add frequency, antenna factor, and gain values to the antenna definition by entering the values in the 
list. Either Antenna Factor (dB) or Antenna Gain (dBi) values can be added. The editor will calculate the 
other to match. For faster entry, the Antenna editor automatically advances to the next field in the 
current amplitude column as you type values and press Enter.

6. To upload an antenna file, open it and then press the upload icon. Regardless of the name of the file, 
MST will try to upload it as antenna.txt and will ask you whether to overwrite the remote file.

7. After the upload, power off the instrument, then on.

5-3 Signal Standard Editor (SignalStd.sig)
The signal standards editor is organized in a tree structure. When a signal standards file is opened, the 
standards are shown in a connected list with a + sign to the left. To edit an entry, expand the definition by 
clicking the + symbol. Standard editing functions are available in a right-click context menu. This feature 
provides Cut, Copy, and Paste operations, as well those to add new signal standards and delete unwanted 
entries.

Figure 5-2. Sync Pull-down Menu
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To edit a value, select it in the list and type the new value. You may use the edit box at the top of the window 
for convenience. Press Enter after editing the value in order to automatically shift focus to the next field. Save 
the file using Save to keep the original SignalStd.sig name or Save As to save with a different name.

To upload a signal standards file open it and then press the upload icon. Regardless of the name of the file, 
MST will try to upload it as SignalStd.sig and will ask you whether to overwrite the remote file.

5-4 Cable Editor (Cablelist.txt)
The cable editor provides a list of cable definitions. To edit a cable definition, select the field to be modified and 
enter a new value. New cables can be added by entering the values in the last row, which is empty. To remove 
a cable, select it and press Delete. The software prompts for confirmation.

As with antennas and signal standards, the cable list file must have the expected filename in order to be 
recognized and used by the test instrument. The test instrument name for this file is Cablelist.txt. This is the 
name of any cable list that is downloaded from an Anritsu test instrument. 

To upload a cable list file, open it and then press the upload icon. Regardless of the name of the file, MST will 
try to upload it as Cablelist.txt and will ask you whether to overwrite the remote file.

5-5 Pass/Fail Test Editor (TestModels.txt)
The WCDMA/HSDPA, GSM/GPRS/EDGE, Fixed WiMAX, Mobile WiMAX, CDMA, EV-DO, TD-SCDMA, LTE, 
and TD-LTE measurement modes support a Pass/Fail measurement mode. In order to edit the Pass/Fail test 
definition file, connect to the test instrument and set it to one of the measurement modes.

From the toolbar select Sync > Download Pass/Fail List sub-menu, choose either GSM/GPRS/EDGE Pass/Fail 
List, WCDMA/HSDPA Pass/Fail List, Fixed WiMAX Pass/Fail List, Mobile WiMAX Pass/Fail List, CDMA 
Pass/Fail List, EV-DO Pass/Fail List, TD-SCDMA Pass/Fail List, LTE Pass/Fail List, or TD-LTE Pass/Fail 
List.

To edit, select the field to be modified and enter a new value. The Pass/Fail editor attempts to present all 
possible parameters and values in a simple grid. As different rows are selected, the column headings change in 
order to reflect the values and units of the selected parameter. Some test parameters have fewer constraints 
than others do, so some field values are blank. The bottom of the Pass/Fail Editor provides information about 
parameter types and units. 

To upload a Pass/Fail file, open it and then press the upload icon. Regardless of the name of the file, MST will 
try to upload it as testModels.txt and will ask you whether to overwrite the remote file.

5-6 Setup Files (*.stp)
Setup files, which can be saved and recalled on a test instrument, can also be downloaded into MST. 
Downloaded setup files can be stored and can be used to upload a common setup file to a number of test 
instruments to ensure that they are all configured in the same manner.

These files cannot be edited, but they can be viewed, saved, printed, exported, and a report can be created from 
a setup file. When a setup file is opened, only the file header is presented. The window may be resized to show 
other parameters, but these parameters are not in an easily readable format and cannot be edited.

5-7 Calibration Files (Cal*.txt)
As with setup files, calibration files cannot be edited in MST. For calibration files, MST has no facility for 
printing, exporting, or creating reports. No benefit is derived from uploading a calibration file from one test 
instrument into another or from recalling a calibration file in MST, but these files are stored in the user 
memory space and have a common syntax and a .txt extension. These files may be viewed. The filename syntax 
(Cal*.txt) allows quick identification of the file type.
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5-8 JPEG Files (*.jpg)
The test instruments that are supported by MST all provide a function to capture the current screen and save 
the displayed measurement as a JPEG image file. These files are in the Device File list and can be seen when a 
test instrument is connected to MST. The viewer provides a method to see these stored image files. A JPEG file 
cannot be edited in MST, but can be printed from MST. Refer also to JPEG Save Options in the Program 
Options window for additional information about saving JPEG files.

5-9 Reports (.pdf and .html)
All measurement files and most support files can be saved in reports. Reports provide a useful way to create 
hard copies of complete measurements, which contain more information than by printing the measurements 
themselves.

There are two formats to choose from, HTML or PDF. The report formatted in HTML can be displayed in an 
Internet browser. To view a PDF file you will need Adobe Acrobat Reader. You can obtain this free software by 
going to http://www.adobe.com/downloads/ and click Adobe Reader. Follow the instructions for downloading 
and installing it to your computer.

Reports typically have a header with company name, logo, date and time stamp, and GPS coordinates (only if 
GPS was on and locked) of the measurement. This header is followed by a picture of the measurement, a table 
of relevant parameters for the measurement, and the test instrument on which the measurement was 
captured. An optional signature line is at the bottom.

All of the items in the header and the signature line may be eliminated or pre-configured by using the settings 
on the Report tab of the Program Options dialog box. 

To configure the report and file type:

1. Pull down the Tools menu and click the command Program Options. The Program Options window opens.

Figure 5-3. Tools Pull-down Menu
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2. Click the Report Generator tab.

3. Configure the report as desired using these settings: 

Report Header: Selects the elements for the report header:

• Report Title—The title placed at the top of the report. Type up to 40 characters.

• Company—The name of the client company. Type up to 40 characters.

• Prepared For—The name of the measuring company/personnel. Type up to 40 characters.

• Location—The GPS coordinates of the measurement if the GPS feature was active.

• Date & Time—The data and time of the measurement, not of the report.

• Company Logo— Click the folder button, to find the logo file through a file browser.

• Logo Align (left, right, or center aligned)

Open With: Selects the default viewer

• Default Editor (Microsoft Word, Front Page, etc.) (only for HTML reports).

• Default Viewer (Internet Explorer, Acrobat Reader, etc.).

• Other (User Specified). Click the folder button, which opens a file browser, to find the appropriate 
application, or enter the full path.

Signature Line: Appends a signature line to the report with Prepared By and Approved By lines.

Output Format: Selects the file type to be generated.

• PDF—Adobe Acrobat format. Cannot be paired with a default editor. A report is not generated in 
this case.

• HTML—Hypertext Markup Language.

To generate a report:

1. Set report settings.

2. Click File>Create Report in MST main window.

To store a report, use Save As (or other function, depending upon browser or viewer) to a different location. 

Figure 5-4. Program Options Window
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The main section of the report contains a JPEG image of the measurement. This image is created in the same 
location where the active measurement file is located in the local disk space.

Figure 5-5. PDF Version of a Measurement Report
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5-10 Exported Files (*.csv, *.txt)
Exported files may have either *.csv or *.txt filename format, depending upon the method chosen to create the 
export file. When exporting a file, select the correct option from the Save as type: drop-down list. The options 
are designed to assist with differences across cultural and geographic world regions. Choose among the 
following: comma delimited, semicolon delimited, tab delimited with a period for decimal separator, and tab 
delimited with a comma for decimal separator.

These file conventions are chosen to work well with Microsoft Excel when using different regional settings. 
MST is designed to default to the most likely option based upon the regional settings of the computer. If the 
exported file is intended for another part of the world, different settings may be required in order for the files to 
be opened correctly.

5-11 Folder Spectrogram Files (*.fsg)
A Folder Spectrogram file is a special composite-file created from all of the SPA or IA spectrum measurement 
files contained in a selected folder. All of the files (that are to be used) in the folder are assumed to have the 
same frequency range, which is the frequency range of the first file.

A Folder Spectrogram file is especially useful to get a composite view of a large number of traces that are 
stored using Save on Event. This mode of the test instrument allows a spectrum analyzer trace to be stored 
each time that a set criterion is met, such as peak amplitude above some preset limit, or at the end of each 
trace sweep. Many thousands of saved traces can quickly accumulate this way, and viewing and evaluating 
each one is difficult.

Folder Spectrogram files allows a user to quickly review all traces and pick out the specific traces of interest. 
Several different graphs are provided to review the composite data sets, and post-capture filtering can be done 
based upon specified criteria.

To create a Folder Spectrogram file:

1. Pull down the File menu.

2. Highlight New and the click Folder Spectrogram in the sub-menu. The Browse For Folder dialog window 
opens. Take note of the message at the top of the dialog window.

Figure 5-6. File Menu to Select Folder Spectrogram
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3. Read carefully the note at the top of the dialog window.

4. Highlight the folder that contains either the SPA or IA spectrum files and click OK. MST opens each 
trace file and creates a single composite file containing all of the trace data. The spectrogram window 
then opens in the Average view.

MST will open each file and create a single composite file containing all of the data. All of the trace data are 
sorted according to the measurement time stamp, and a spectrogram display is presented. Depending upon the 
number of files, creation of the composite spectrogram file may take from approximately 5 seconds to 30 
seconds.

Figure 5-7. Program Options Window

Figure 5-8. Average View Window - Default Window
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Spectrogram
A spectrogram shows signal versus time in a simulated three-dimensional top view, with the x-axis being 
frequency, the y-axis being time, and color showing power. Below the spectrogram is a view of the currently 
selected trace. The selected trace is indicated by a red line on the spectrogram. To select a different trace, use 
the mouse or cursor keys to move the red line. To the right of the spectrogram is a bar that adjusts the contrast 
of the spectrogram.

Figure 5-9. Two-Pane Spectrogram Window
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Color Selection Configuration Window
The Color Selection window allows you to configure the color bar and spectrogram color parameters. Place the 
mouse on the color bar left of the spectrogram and click the left mouse button. The Color Selection window 
opens. 

Color Bar: You can customize the colors of the color bar. Place the cursor on the desired color to change. 
Click the left mouse button and the Color window opens. Click the desired new color and press OK. The 
previous color is replaced by the new.

RGB Color Adjust: There are three primary color controls – red, green, and blue. They control the overall 
color tone of the color bars. Use the Up/Down arrow adjacent to the blue control to increase or decrease 
the tone setup in the RGB controls.

Brightness: Lightens or darkens the colors on the color bar.

Contrast: Defines or blends the lines between colors.

Scale Factor: Use this feature to increase or decrease the dBm scale value and number of dBms per color.

Minimum Threshold: Raises or lowers the minimum threshold value.

Save: Saves the new color bar settings. 

Reset: Returns all changes made in the Color Selection configuration window to the default setting.

Cancel: Cancel any changes made and closes the Color Selection configuration window.

Figure 5-10. Color Selection Window
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Folder Spectrogram Context Menu
Select the context menu (mouse menu) by right-clicking the mouse over the Folder Spectrogram Window. This 
gives access to a menu of advanced options and features.

• Data Display Options…

File Filter: Filtered files are displayed in the box to the right of the selections. The filtered file list is sorted 
based upon the selected column, either filename or frequency of peak or measurement time stamp. 
Filtered files show up in red in the spectrogram and time chart display modes.

None: No Filtration.

Limit Line from a measurement: Shows only traces that go above or below the set limit lines.

Deviation from the average (dB): Filters out files that deviate from the average by more than a 
specified amount of dB. Upper and lower ranges are set in addition to the filter window width.

JPEG and AVI Settings: These settings set up the parameters for saving measurement files as JPEGs 
(stills) and AVIs (videos).

JPEG Options: Choose between Small (320x240), Medium (640x480), Large (1024x768), or 
customized ratio. The Quality may also be selected.

AVI Options: Choose between Small (320x240), Large (640x480, or customized ratio. The frame rate 
may also be changed as desired. One frame is one trace.

• Save Window (entire spectrogram) as JPEG 
Saves the current window as a JPEG image file.

• Export to csv (Spreadsheet) 
Saves the Folder Spectrogram composite data file as a CSV (comma separated values) file, to a location 
and file name of your choosing, that can be imported into a spreadsheet application.

• Save All to JPEG 
Saves all traces in JPEG format. This action creates a sub-folder named Images, where all images are 
stored. This command’s progress is a bar at the bottom of the Folder Spectrogram window.

• Create AVI 
Creates an AVI video file of the traces. This action creates a file called Folder.avi in the same folder as 
the trace files. When done creating the file, a message displays asking if the file should be played on the 
default video player.

• 3D Spectrogram View 
Opens the 3D Spectrogram window to view the list of traces in 3-dimensions – frequency, time, and 
amplitude. Refer to Chapter 4, “Using MST”.

Figure 5-11. Folder Spectrogram Context Menu
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• Folder Spectrogram Buttons

The buttons shown in Figure 5-12 change the view of the data in the window. 

Peak Power: Peak power shows the highest power at each frequency.

Total Power: Total power shows how much power is present over time in that band.

Peak Freq: Peak frequency shows which frequency has delivered the highest power over time.

Time Chart: The time chart shows the number of occurrences per time increment. The number of time 
increments depends upon the size of the window. The earliest and latest measurements set the start and 
stop time increments with the intervening increments being uniformly distributed (in time).

Average: Average shows the lowest, highest, and average power levels of all frequencies.

5-12 Trace Indexing and the Trace Catalog
The Trace Index is a database containing the location and key parameters of all measurement files that are on 
the local hard disk. This is a convenient way to organize, locate, and manipulate measurements when many 
measurement files are spread across a number of folders.

Trace Catalog
With the Trace Catalog, a user can perform the following tasks:

• Index all supported files on the hard disk.

• Index measurement files on a network drive.

• Store multiple indexes for different clients or regions.

• Perform automated indexing on a fixed schedule.

• View files in either a detailed list or as thumbnails.

• Archive files (Zip) from multiple folders.

• Cut and copy measurement files.

• Open measurements for editing.

• Select just the measurement types that are of interest.

• Sort measurements by name, date, or key measurement parameters.

• View statistics on number and location of all supported file types.

• Locate missing measurements that are hard to find.

Figure 5-12. Folder Spectrogram Buttons
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Trace Catalog-Spectrum Analyzer Window
Beneath the Trace Catalog toolbar buttons is the Trace Catalog File List window. This window displays files 
that have been indexed. Files are listed in the format selected using the Display Format button.

Trace Catalog-Spectrum Analyzer Toolbar
These are the toolbar tools:

Refresh Index:  Clicking this command displays this message. Click Yes to index the files. This action 
refreshes the trace index based on selections made in the Index and Scheduling Options dialog, 
Figure 5-15.

Figure 5-13. Trace Catalog Analyzer Toolbar

Figure 5-14. Re-index now Dialog
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Index and Scheduling Options: Opens the MST File Indexing window. See also the description for 
Figure 3-99 for more information about this dialog.

Archive Index Database: Opens the Archive Options window to create a Zip file archive from the 
database.

Copy: Copies files to clipboard.

Cut: Removes files from index only.

Figure 5-15. MST File Indexing Window

Figure 5-16. Archives Options Window
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Delete: Deletes selected file from index permanently.

Display Format Button: Controls how data file is listed: Details, Small Icons, or Large Icons.

Details: See Fig. 3-36 Trace Catalog Analyzer Toolbar.

List- Small Icons: List files with the graph picture as small icons.

List - Large Icons: List files with the graph picture as large icons.

Figure 5-17. Delete File Message Dialog

Figure 5-18. List File Display as Small Icons

Figure 5-19. Trace Files Displayed as Large Icons
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Select File Type: Drop down menu to select indexed file types to be displayed in the Trace Catalog 
window.

Load/Reload the File List: Initially loads the file/files into the Trace Catalog window. Reloads and 
updates to the list additional files that have been indexed.

Show Summary: Opens the Catalog Database Summary window. Click OK to close the summary.

View Indexing Log File: The log file is in .txt format so, the text file opens in Notepad. 

Figure 5-20. File Type Selection List

Figure 5-21. Catalog Database Summary

Figure 5-22. Trace Rename Log File
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Clear Log File: Clears the indexing log file.

From the Main Menu, select Tools>Full Trace Retrieval to open the Trace Retrieval Dialog box. This 
dialog displays:

Two buttons, Destination and Retrieve All, are provided, each accompanied by a text box for 
entering a path and filename.

For saving a measurement, click Destination, and the Browse For Folder window opens. The 
window message reads:

“Select a folder to save the remote measurement files to.”

A menu tree of folders and files is provided for the selection. Select a folder from which to retrieve 
files and the Retrieve All button activates. Clicking starts the retrieval of all the files from that 
folder. Click Cancel at anytime to stop the action.

Note This feature is only supported by Ethernet connection; neither USB nor serial connections are 
permitted.
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5-13 Filter Editor for ISDB-T (*.isdb)
The Filter Editor is used to edit or create ISDB-T filter files. These files are accessed in the instrument when 
the Filter Selection submenu key is pressed and the Select Filter dialog opens.

To create a new ISDB-T file within MST, pull down the File menu click New and then click ISDB-T Filter File. 

Figure 5-23. ISDB-T Editor Window

Figure 5-24. New Pull-down Menu



Support File Management 5-13 Filter Editor for ISDB-T (*.isdb)

Master Software Tools UG PN: 10580-00439  Rev. B 5-19

To edit a filter file on the instrument, download the file into MST by pulling down the Sync Menu and clicking 
Download ISDB-T Filter List. 

Both created or downloaded files will contain a Default filter on the list. Edit either default filters by clicking 
the desired node value - Frequency Offset or Attenuation. Type in the new value and press the Enter button on 
the computer keyboard. 

The downloaded file contains one Default filter and three user filters – User1, User2, and User3. As with the 
Default filter, Filter Names, Frequency Offset, and Attenuation values can be changed by clicking the filter 
name or desired value. Type in the new value and press the Enter button on the computer keyboard. 

Upload the edited filter file by pressing the Upload button on the Toolbar. Closing the edited files automatically 
saves these files to the default directory in the computer.

Figure 5-25. Sync Pull-down Menu
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Chapter 6 — Advanced Features

6-1 Introduction
This chapter describes the advanced features and program options of MST.

6-2 Advanced Tools and Program Options
The following advanced features and program options are available under the Tools main menu.

Group Edit
This tool allows modification of a large number of measurement files at one time.

All of the following attributes can be reset:

• Measurement title

• Measurement subtitles

• Limit lines

• Marker positions

• Plot scaling

Specify a particular file type on which to operate and choose whether to modify files in a specified folder or to 
modify all currently open measurement files. When modifying open files, changes can be viewed as they occur. 
The changes are temporary unless the files are saved.

Full Trace Retrieval
This tool simplifies the retrieval of large numbers of traces from a test instrument into a user-specified 
directory via an Ethernet connection. When a test instrument contains many measurement files, this tool can 
be used to retrieve all measurements in one step. The process can be slow if the number of existing 
measurements exceeds several hundred.

VNA Measurement Calculator
This tool translates certain values into other units. It can show Real and Imaginary values, Magnitude, Phase, 
Return Loss, Reflection Coefficient, and Transmission Power. Enter a value in any field, and the other fields 
are adjusted automatically.

DAT File Conversion Tool
This utility is used to convert saved traces (.dat files) from Handheld Software Tools to the format that is used 
by MST. This conversion is not a reversible process because no equivalent utility exists to convert newer traces 
to the older format. The utility does not delete trace files in the old format and in the new format uses different 
filename extensions, .spa or .vna. (The old traces remain available for use with the Handheld Software Tools 
program.)

To convert a .dat to a MST compatible file:

1. Open the Tools menu in MST and select DAT File Conversion Tool.

2. In the Source area at the top area of the window, navigate to the directory that contains the traces that 
are to be converted.

3. In the Destination area, select the directory into which the converted traces are to be placed.
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4. Select the Conflicting Filenames option that is to be used – Keep Existing, Overwrite, Prompt (for a 
decision), or Skip (skip the conversion of the file for which a conflict exists).

5. Select the measurement or measurements to be converted.

6. Click the Convert button. Note that the new traces appear in the destination window. Before the 
conversion, select View to preview the file in the new format, if desired. See Fig, 3-21 DAT File 
Conversion Tool Window

6-3 Trace Rename Utility
This utility application can be used to quickly rename (filename, measurement title, and/or measurement 
subtitle) a large set of measurement files in a very systematic way. To use this utility effectively requires some 
forethought in how the measurements are taken. 

Step 1: Transfer the list of files from your test instrument to the computer
1. Pull down the Sync menu and click the command line Download All Measurements.

The Browse For Folder window opens. 

Figure 6-1. Sync Menu
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2. Select a folder where the traces will be stored or make a new folder by clicking the Make New Folder 
button.

3. After the destination folder has been selected or created, click OK. Downloading the file begins.

4. Click the Close button when the statement Transfer Complete displays.

Figure 6-2. Browse For Folder

Figure 6-3. Download All Measurements Dialog
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Step 2: Rename the Traces That Have Been Retrieved
1. Pull down the Tools Menu and click Trace Rename Utility. 

2. The MST Rename Utility application opens.

3. Click the Working Folder button. This is the folder where the traces-to-be-renamed are located and will be 
stored.

Figure 6-4. Tools Menu

Figure 6-5. Trace Rename Utility



Advanced Features 6-3 Trace Rename Utility

Master Software Tools UG PN: 10580-00439  Rev. B 6-5

4. Place the cursor on the pull down menu and select the type of file to be renamed. Those traces are loaded 
into the utility.

5. Highlight any traces not to be renamed and click the Delete button. The selected traces are removed from 
the list.

6. Activate a rename field by clicking the box for that Field column.

7. Enter names in each active field.

8. If you want to the program to cycle through each parameter:

a. Check the Auto-Advance button. The order you click the Auto-Advance check box determines the 
order the fields will cycle. 

b. Turn off Auto-Advance for all fields.

c. Turn them on in the order of precedence. A number will appear in the Auto-advance label 
indicating the field’s order. The field marked Auto-Advance (1) will cycle through its values first 
then when it cycles back to the top value, the Auto-Advance (2) field cycle to its next value and so 
forth.

9. From the toolbar select the object that you want renamed – Filename, Titles or sub-Titles.

10. After you’ve activated your fields, names, and Auto-Advance selections, you can rename each trace 
manually or automatically.

a. Rename Manually

To activate Manual Renaming of measurements, select the Manual toolbar button: 

• When in Manual mode, double-click a file, or select a file and press Enter. 

• The change will take place immediately.

• Auto-advance fields will advance each time.

• If you use the Enter key, the file selection will move down automatically.

Figure 6-6. Trace Type Selection Menu

Figure 6-7. Trace Rename Table
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b. Rename Automatically

To process many files at once: 

• Select the target files and press the Apply Selected button, 

or 

• Press the Apply All button, to change all the filenames in the list.

Trace filenames in this example have been renamed. They have been immediately stored with the new names 
in the working folder file. This procedure can be used to rename the trace’s title and subtitle.

Note The changes are immediate and cannot be undone in the classic sense; but they can be redone 
easily to correct any mistakes.

Figure 6-8. Trace Rename Log File
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6-4 Modifying or Defining a Language
The Language Editor allows for modification of the language that is already in the instrument (except English) 
and also provides the ability to add two custom languages to the test instrument.

The standard language files that are provided in the test instrument may be modified, except for the default 
English file. In addition, two Custom files are available (in English) that may be completely rewritten in 
another language if desired. For most entries, a limit exists on message length because of the need to fit the 
message on a soft key or in a message box. The fonts that are used for the on-screen messages are proportional, 
meaning that different characters can take different amounts of space. Some creativity may be necessary in 
order to fit the words into the allotted space. Ideally, the customized language message should not take up 
significantly more space than the English equivalent. Always test the customized language by uploading it into 
the test instrument and reviewing the menus to be sure that the key labels fit into the available space and are 
fully discernible.

To modify a language file, select the Sync menu, select Download Language Table, and select System 
Language File. Select the language to be modified from the choices at the bottom of the editor.

The file tree expands to show the three groups of labels that are available for editing. Select the group of labels 
you want to edit: Button Captions, Generic Text, and Parameter Names.

In order to change the label of a parameter, click to select the Parameter you want to change and type the new 
text in the bottom window. Save the modified language file to the computer hard disk, and then upload it into 
the test instrument.

6-5 Group Edit
This utility application allows you to rename titles, subtitles, and parameters of measurement files grouped 
together within a directory or selected by measurement type. To use this utility effectively requires some 
forethought in how the measurements were taken. 

Figure 6-9. Selecting a Language to Modify

Note

Special fonts for some languages must be installed on the system in order to edit those languages. 
Please contact your font vendor for specifics.
Before uploading to the test instrument, the files are to be saved as vna.znc for the VNA language 
file, and system.znc for the system language file.
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1. Pull down the Tools menu and click Group Edit.

The MST – Measurement Group Edit window opens. 

2. Selection Scope - Select the location of the files to be edited.

a. Apply to all open files of selected type. This selection edits a group of files, file type determined in 
Application Type: in the Active Measurement Window. Placing a check in the box, next to Commit 
Changes to Disk save all changes which cannot be undone.

b. Apply to all files in the specified folder. This selection edits a group of files in the folder.

3. Measurement Titles – Check the box next to the Plot Title or Plot Subtitle that you desire to change. 
Enter the new title or subtitle into the entry boxes. Use {date}, {time}, {count}, {GPS}, and {filename} to 
insert parameter values from each measurement file. You may also use {[VAR]}, where [VAR] is any 
parameter in the saved measurement. (i.e. {Center_Freq} or {OCC_BW_MEASURED_DB}. 

4. Parameter Duplication –

a. Check the desired parameter box that you want to duplicate.

b. Browse the folder for the file with the parameter to be duplicated. Select it and its name displays 
in the entry box.

5. Press Apply button. Titles and parameters are saved as set up in steps 2 through 4.

Figure 6-10. Tools Menu, Group Edit Command Line Highlighted

Figure 6-11. Trace Rename Log File
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Chapter 7 — Instrument Update

7-1 Introduction
Occasionally, Anritsu places updated software, firmware, and documentation on its Product Support Web Site. 
The website can be queried for MST-supported updates. 

7-2 Internet Settings Configuration
To query the Anritsu website for updates, you must configure the MST Internet Settings.

1. On the Tools menu, click Program Options. 

2. The Firmware Update Tip dialog opens. It informs you of an improved method of updating USB-enabled 
handheld instruments (“Firmware Update from an Anritsu Website File” on page 7-9). Press the OK 
button when done.

The Program Options window opens.

Figure 7-1. Tool Menu: Program Options Command

Figure 7-2. Firmware Update Tip Dialog
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3. Click the Internet Settings tab.

4. Check the box labeled Automatically check for updates from Anritsu’s Product Support Web Site to receive 
updates automatically from Anritsu.

5. Then in the Proxy Settings box, click the check box preceding the statement – Use a Proxy Server to 
access the Internet content.

6. Enter your username, password, and network domain name in the respective entry boxes. You may need 
to ask your IT administrator for the domain name if you do not know it.

7. Click OK.

8. Close and restart MST.

9. Returning to the Tools menu, click Product Updates.

Figure 7-3. Internet Settings

Figure 7-4. Tools Menu: Product Updates Selected
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10. This message is displayed. After reading it, click OK.

The “Product Updates Window” opens. 

7-3 Product Updates Window
There are a few ways to use this window:

• If the file status for the firmware update is Ready and the Install to Unit button active, the firmware 
may be installed directly. See “Update an Instrument’s Firmware Directly” on page 7-6

• If the file status for the firmware update is Ready and the Prepare Ext. USB Device button is active, you 
may download the firmware to the USB and update the firmware. See “Update Instrument Firmware 
with USB from MST” on page 7-7. This method might be good if you have several of the same instrument 
to update. 

• If the entry in the File column says Use Go To Website Button, there is only one way to update the 
firmware and that is to prepare a USB following the instructions on the Anritsu Web page. See 
“Firmware Update from an Anritsu Website File” on page 7-9. 

Figure 7-5. Product Update Message

Figure 7-6. Program Updates Window
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Notice in the top, right corner of the window, a box labeled Internet. Confirm that the box is colored green. If 
so, there is an active Internet connection. If red, return to the Program Options window and re-enter your 
correct Username, Password and network Domain information. The actions that can be done from this window, 
through buttons are described here:

• Go To Website – This button is active only for those rows which contain the text Use “Go To Website” 
Button in the File column. Pressing this button opens the Anritsu firmware page for the family of 
instruments related to the instrument. Select the correct update method for updating your instrument 
and follow any subsequent instructions.

• Revision Details – This button is not active for those rows which contain the text Use “Go To Website” 
Button in the File column. It opens the Customer Service Revision text file for the instrument selected. 
This file contains pertinent information regarding the instrument such as general features, firmware 
updates, a history of changes, and fixes.

• Retrieve File – This button is active for those rows which contain which contain a .zip filename in the File 
column. If the instrument’s file highlighted Status is Available, use this button to retrieve a file from the 
Web to place on your computer. When the file is on the computer, its status will change to Ready.

• Check for Updates – This button is active only for instruments that show Use “Go To Website” Button. It 
checks for recent versions of firmware placed on the Anritsu Website.

• Install to Unit – This button is only active when the file status for the highlighted firmware is Ready and if 
the instrument is connected. Emergency Repair – This feature allows you to recover from corrupted 
operating system firmware. This feature is only available for instruments that have the Ready status; 
the button will be grayed out for all that cannot use this feature (i.e. Available status). By pressing this 
button, a OS Recovery dialogue opens with a list of instructions. Refer to Section 7-6 “Emergency Repair 
Procedure” on page 7-12 for complete procedure instructions.
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7-4 Updating MST Software 
1. On the Tools menu, click Program Updates. 

2. The Firmware Update Tip dialog opens. It informs you of an improved method of updating USB-enabled 
handheld instruments (“Firmware Update from an Anritsu Website File” on page 7-9). Press the OK 
button when done.

3. Click MST entry in the Product Update window. 

4. Click Retrieve File and follow the instructions in the window. 

Figure 7-7. Tools Menu: Product Updates Command

Figure 7-8. Firmware Update Tip Dialog

Figure 7-9. Firmware Update Tip Dialog
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7-5 Updating Instrument Firmware

Update an Instrument’s Firmware Directly
1. On the Tools menu, click Program Updates. 

2. The Firmware Update Tip message dialog opens. It informs you of an improved method of updating 
USB-enabled handheld instruments (“Firmware Update from an Anritsu Website File” on page 7-9). 
Press the OK button when done.

3. Click Retrieve File.

4. After the status changes to Ready, click the now active Install to Unit button. The test instrument is 
updated with the new firmware.

Note

MST does not directly support E-Series instruments. Support for them is only through a USB 
memory device that is prepared from the files available from the appropriate Anritsu Website 
instrument page. After the USB memory device is prepared, review your instrument’s User Guide for 
instructions regarding updating the firmware with the USB memory device. 

Figure 7-10. Tools Menu: Product Updates Command

Figure 7-11. Firmware Update Tip Dialog
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There may be instances after opening the Products Update window when you do not find the file you are 
looking for. In that case:

a. Click Check for Updates. MST checks for the latest updates in the Anritsu’s Product Support Web 
Site. New updates found will be listed in the File menu. 

b. Click Retrieve File. MST transfers the file from the website to computer.

c. If the file you need is still not listed contact Anritsu support.

5. At this point, click Install to Unit (certain legacy instruments). 

Update Instrument Firmware with USB from MST

1. Place a blank, high-quality USB memory device into your computer’s USB slot. 

2. Click Prepare Ext. USB Device. Click OK on the information dialog.

3. Select the USB drive in the Browse For Folder dialog.

Note Anritsu strongly recommends that you remove from the memory stick, any preloaded software files 
put there by the manufacturer. To accomplish this, format the memory stick as a FAT 32 drive.

Figure 7-12. Firmware Ready to Install to Unit
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4. Click Make New Folder to begin the device preparation.

5. Give the folder any name you want. Press Enter to accept the new folder.

6. Click OK to copy the files. Continuing progress is indicated by the Progress monitor.

7. A Code Loading Instructions dialog opens after the image creation on the USB memory stick is complete.

8. Place the USB Memory stick in the instrument’s USB Port and follow the Code Loading Instructions.

9. When done, Click OK on the Code Loading Instructions dialog.

Figure 7-13. Browse for Folder Dialog

Figure 7-14. Progress for USB preparation

Figure 7-15. Code Loading Instructions Dialog
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Firmware Update from an Anritsu Website File 
To update your Anritsu instrument firmware, use a blank, high-quality USB memory device with at least 
250 MB of free space and FAT32 file system format. This procedure applies only to instruments with USB 
ports and only to instruments with Use “Go To Website” Button in the File column. Instruments without USB 
ports might need to use the firmware update procedure found in the instrument’s user guide.

1. Insert the memory device into your computer.

2. From a browser, go to the Anritsu.com, and search “modelnumber update”.

3. Check both Downloads and Support. The result of the search should bring the appropriate link near the 
top of the list. Click the link.

4. On the product page, click the Downloads button.

You can, optionally, follow the Release History link to download a document detailing current and past 
firmware changes.

Figure 7-16. Search for Firmware Update

Figure 7-17. Download the Firmware

Figure 7-18. Update History



7-5 Updating Instrument Firmware Instrument Update

7-10 PN: 10580-00439  Rev. B Master Software Tools UG

5. Choose to Save or Save A the file. Do not run the executable file directly from the Web page.

6. Go to the save location designated in Step 5 and double-click to run the installer file, 
Model_Ver_USBLoader.exe.

7. In the Firmware Update dialog, click to review, then accept the software license agreement.

8. Click Browse and select the removable disk drive where the USB device is inserted.

9. Click Prepare USB Memory Stick to create the firmware update USB device.

10. After the firmware update tool has finished, click through the final steps in the Firmware Update dialog 
to close the installer program.

11. Eject the USB memory device from the computer.

12. Turn off the instrument and insert the USB memory device into the instrument.

13. Make sure the instrument is plugged into an AC power source and not running on battery alone; then 
turn on the instrument.

14. During bootup, the instrument should detect new firmware on the USB device and ask if you want to 
upgrade. Press Yes.

15. The Automatic Firmware Update dialog should open at this time. If it does, skip to Step 16. 

If there is no error but the instrument does not enter upgrade mode automatically:

a. Press Shift > System (8) > System Options > Reset > Update Firmware.

b. Press Load Firmware at the bottom left of the instrument screen.

c. Press Update Application Firmware.

d. The Firmware Update dialog opens.

16. Use the up/down arrow keys or the rotary knob to select one of the Save modes.

• Save none: No attempt is made to save any user data.

• Save user data: User data is saved to the selected external media device.

• Save & restore user data: User data is saved to the selected external media device. The instrument 
also attempts to restore the files to the instrument after the update. 

17. Press Enter.
To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and select an 
application from the Mode Selector list in order to exit upgrade mode and resume normal instrument 
operation. 

Note The file structure created on the USB memory device by the installer program is necessary for a 
successful firmware update and must not be altered in any way.

Note

If the same version code as contained on the USB device is already loaded on the instrument, a 
message indicating that firmware update is skipped will display briefly on the instrument screen.
If the firmware update on the memory device does not match your instrument model, an error 
message will display briefly, indicating that it is not compatible.

Warning
The same USB device used to do the firmware update will be the temporary holding device for all 
traces on the instrument. If the number and size of the saved files on the instrument exceeds the 
available space on the USB device, user data will be lost.
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18. Press Enter again to confirm your intention to proceed with the firmware upgrade.

19. After the update is complete, the instrument should reboot automatically. 

Warning You cannot stop the upgrade after it has started. To avoid potential permanent damage, do not turn 
off the instrument nor remove the USB memory device during the firmware update.

Note

If the instrument turns off but does not restart on its own, remove the USB memory device and 
perform a master power reset:

1. Press and hold the System (8) key. 

2. Press the Power button and release it.

3. Hold System (8) key until the Anritsu splash screen displays; then release it.

Be sure to use this procedure to perform a master power reset while turning on the instrument. 
Pressing the Power button alone may put the instrument into an unrecoverable error state.
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7-6 Emergency Repair Procedure
If you have problems with booting up or updating firmware on the test instrument, use the following steps to 
resolve the problem.

1. Power off the instrument.

2. Prepare a firmware update USB device as described “Firmware Update from an Anritsu Website File” 
on page 7-9, and insert it into the instrument. Double-check that you have the correct model firmware.

3. Power up the instrument into bootstrap mode, choose either:

• On touchscreen instruments, hold Shift, 4, and 0 keys while powering up.

or

• On non-touchscreen instruments, hold the 1st, 3rd and 5th soft keys, located right of the display 
directly below the Esc key, while powering up. 

The Bootstrap screen (similar to below) will appear after a few seconds.

4. Press Load All. The instrument will reload available applications and FPGA firmware and return to the 
above screen when complete.

5. Press and hold the System (8) key.

6. Press the Power button and release it.

7. Continue to hold the System (8) key until the Anritsu splash screen displays; then release the button.

8. Reboot and the instrument should start up normally.

Warning It is vital that the correct instrument model firmware is downloaded during the following step or 
irreversible damage to the instrument can occur.

Figure 7-19. Option Upgrade Complete Notification Window

Note Use the other choices only as directed by Anritsu customer service.

Bootstrap version x.xx
<keypress>
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7-7 Generating an Instrument Config File and Installing A New License File
The config file is the essential first step prior to receiving a license file from Anritsu customer service.

To automatically query the Anritsu website for updates, you must configure the MST Internet Settings.

1. Run the MST program.

2. Connect to the instrument.

3. Generate a Config File:

a. Pull down the Sync menu and highlight Device Status and Options to open the sub-menu.

b. Click Get Options (Config File). The Save Config File window opens.

c. Navigate to the folder containing the configuration file.

d. Select the desired folder or create a new folder to save the config file. Use the file name given in the 
entry box. (The filename format is predetermined: Model-space-serialnumber.config).

Figure 7-20. Get Options Dialog

Figure 7-21. Save Config File Dialog
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4. Send the config file to Anritsu customer service, who generates and returns a license file.

5. Install a license file using the instructions provided with the license file. For the E series and T series 
products, the license file is copied to a USB memory stick and inserted into the unit. When powering on 
the unit, a message temporarily appears stating the options have been updated and a restart is 
necessary to use the new options. For other models, if no instructions came with the license file, follow 
these steps:

a. Pull down the Sync menu and highlight Device Status and Options to open the sub-menu.

b. Click Set Options (License File). The Open License File window opens.

c. Navigate to the folder where you saved the license file supplied by Anritsu customer service.

d. Select the file and click Open. The filename format is model-space-serialnumber.license.

Figure 7-22. Set Options Selected

Figure 7-23. Open License File Dialog
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e. MST installs the new license into the instrument. After the installation is complete, the following 
dialog appears.

f. Follow the instructions in the message. 

g. Verify the new options are listed on the System Status screen.

Figure 7-24. Option Upgrade Complete



7-7 Generating an Instrument Config File and Installing A New License File Instrument Update

7-16 PN: 10580-00439  Rev. B Master Software Tools UG



Master Software Tools UG PN: 10580-00439  Rev. B A-1

Appendix A — Applications and Files

A-1 Supported Anritsu Instruments
For the most recent list of supported instruments, go to Master Software Tools in the Anritsu Website
https://www.anritsu.com/en-us/test-measurement/products/mst.

A-2 Supported File Types
These measurement and data file types are the ones supported by MST.

File Type Extension

Antenna, Cable, Signal Standards *.txt
CDMA Standard files *.cdma
Channel Scanner files *.cs
CW Generator files *.cswg
Display Histogram files *.cpp
DVBTH files *.dvb
DVBTHSFN files *.dsfn
E1 Measurement files *.e1
EV-DO Standard files *.evdo
Fixed WiMAX measurement files *.wmxd
Folder Spectrogram files *.fsg
GSM/GPRS/EDGE files *.edg
Hi-Accuracy Power Meter files *.hipm
Interference Analyzer files *.ia, *.iac
JPEG files *.jpg
LTE files *.lte
Language files *.znc
Legacy Database files *.mdb
Legacy Trace files *.dat
Limit Line files *.lim
Mobile WiMAX measurement files *.wmxe
Mobile WiMAX parameter files *.xml
Power Meter files *.pm
SPA files *.spa
Setup fileS *.stp
Signal Standard files *.sig
T1 Measurement files *.t1
TD-SCDMA files *.tds
TM (Transmission Measurement) files *.tm
VNA files *.vna
WCDMA/HSDPA files *.wcd

https://www.anritsu.com/en-us/test-measurement/products/mst
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These output file types are supported by MST:

File Type Extension

Comma files *.csv
Export files *.s2p
Google Map Export files *.kml
MapPoint Export files *.dut, *.ptm
Report files *.html
Report files *.pdf
Script Master – Channel Scanner files *.smcs
Script Master – GSM/WCDMA files *.pfs, *.c
Spectrogram files *.avi
Trace Copy files *.bmp
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Appendix B — FAQs

B-1 Intermittent Boot-up Problems with Dell Docking Stations

Intermittent boot-up problems have occurred with Anritsu instruments after code loading using MST on Dell 
Latitude D620 and D630 laptops. Problems are related to code loading when the laptop is attached to the 
docking station or with the Integrated USB hub BIOS setting. These problems affect code loading with either 
USB or Ethernet connections. Please follow the steps for your Dell model laptop below to avoid these problems.

Dell Latitude D620 Series Laptops
1. Power off the laptop and remove it from the docking station.

2. Attach either a USB or an Ethernet cable to your laptop.

3. Turn the laptop power on.

4. During the laptop BIOS boot up process, before the Windows screen, press F2.

a. The BIOS page opens.

b.  Scroll down to Onboard Devices using the Down arrow.

1. Press Enter to expand the list.

2. Scroll down to Integrated USB hub.

Note This is only for those instruments which can be updated directly through MST. If you choose to 
update with a USB stick, then disregard this section.

Figure B-1. BIOS Window for USB Hub
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3. Press Enter to modify this setting.

4. Highlight High Speed using the Left/Right arrow.

5. Press Enter when done modifying this field.

c. Press Esc to exit the BIOS Setup.

d. Press the Left/Right arrow to select Exit.
e. Press Enter.

5. Run MST. Follow the instructions for Code Loading in MST. For additional information regarding this 
topic, go to the MST Help menu and click the Help Contents command line. This opens the Help.pdf file. 
Go to Chapter 7 Instrument Files Update.

6. After successfully code loading the Anritsu instrument, power down the laptop, detach the 
communication cable from the laptop, and re-dock the laptop into the docking station.

7. You have the option to return the Integrated USB hub parameter to the factory default setting 
Compatible or keep the new setting, High Speed. 

Figure B-2. Exit BIOS

Note

If you are using or suspect to be using known USB 1.1 rev devices e.g. mouse, keyboard, or have 
intermittent problems with this new setting, follow the instructions in step 4 above to reset Integrated 
USB hub to Compatible. When in the Integrated USB hub field, use the Left/Right arrow to highlight 
Compatible.
Leave the Integrated USB hub setting at High Speed if no USB 1.1 rev devices are in use or no USB 
communication problems occur.
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Dell Latitude D630 Series Laptops
1. Power off the laptop and remove it from the docking station.

2. Attach either a USB or an Ethernet cable to your laptop.

3. Turn the laptop power on.

4. Run MST. Follow the instructions for Code Loading in MST. For additional information regarding this 
topic, go to the MST Help menu and click the Help Contents command line. This opens the Help.pdf file. 
Go to Chapter 7 Instrument Files Update.

5. After successfully code loading the Anritsu instrument, power down the laptop, detach the 
communication cable from the laptop, and re-dock the laptop into the docking station.

B-2 Activating a Different Language 
The following procedure text are for MST users whose computers are in other countries or users who prefer to 
work with their computers in a different language.

1. Open the Control panel.

2. Under Clock, Language and Region, click Add a language.

3. The Change your language preferences dialog displays.

4. Click Add a language. The Add a language dialog displays.

Note These instructions are for a computer running Windows 10. The actual steps for your computer 
might be different if it has a different version of the OS installed.

Figure B-3. Clock, Language, and Region

Figure B-4. Change your language preferences
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5. Select a language and click Open.

B-3 Instrument Password Protection Feature
Some customers require a secure line when using an Ethernet connection between their instrument and MST. 
The password feature is implemented on the instrument. If active, the window in Figure B-6 opens when 
attempting to connect to the instrument from MST. Enter the password and press the OK button. (For more 
information regarding Remote Access Password, please refer to your instrument’s user guide.)

Figure B-5. Add a language

Figure B-6. Instrument Locked Input Dialog
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